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What’s inside?

	 “The 6th edition of the ComicRack Manual is before 

you. This ends a gap of almost 2 years from the preceding 

edition. We experienced more than 25 builds of ComicRack 

during this period. 

	 The past 2 years have seen the release of ComicRack 

apps for Android & iOS (for which we have separate manuals 

and shall not be discussed anymore).  ComicRack for Windows 

also had a very eventful journey. Notable changes were new 

metadata fields, multi-click stacks/groups, query language for 

smart lists, and support for custom fields & shared databases. A 

large number of new (and very good) scripts were developed. 

When I sat down to write the scripts chapter, I realised that the 

scripts are so complicated that they deserve to have manuals 

& wikis of their own, and hence have limited myself to just 

providing the reader with overviews.

	 As I said last time, there is no end to explaining things, 

and increasing the number of pages with every edition just for 

the heck of ‘detailed’ explanation is not worthwhile. So, I have 

managed to ‘trim’ the manual to 100 pages (compare with 

the 179 pages of the 5th edition!).  With this edition, I’ve also 

merged the ‘Tips & Tricks’ manual (never mind if you never 

heard of it!).	
	 The preface will not be complete without me thanking 

my dear friend kenjio, also a senior member of the ComicRack 

team. He has ‘beta-tested’ this edition, giving me his valuable 

suggestions & proof-

reading the words. 

May you always stay 

happy, my friend!

	 I shall never 

forgot to thank cYo for 

his ultimate vision of 

the best comic reading 

and managing software 

ever created, and the 

geniuses at Adobe, 

for making InDesign, 

Acrobat, and Illustrator, 

my tools for creating 

this humble manual.

	 Old readers will 

see a radical change in 

design of the manual.

Hope you enjoy reading it as much as I enjoyed making it!”

				    -600WPMPO

				        18 July 2013
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Are you new to 
ComicRack? This 
chapter introduces 
you to the world of 
eComics & ComicRack. 
Welcome aboard! 

Chapter 01: Introduction

What is ComicRack?� 2
Feature Overview� 3
eComics: Basic Facts� 5
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•	 Supported Operating Systems: Windows 8 (Desktop mode), Win-
dows 7, Windows Vista, Windows XP SP3

•	 Processor: 400 MHz Pentium processor or equivalent (Minimum); 
1GHz Pentium processor or equivalent (Recommended)

•	 RAM: 128 MB (Minimum); 2 GB (Recommended)
•	 Hard Disk: Up to 40 MB of available space may be required
•	 CD or DVD Drive: Not required
•	 Display: 800 x 600, 256 colors (Minimum); 1920 x 1200 high color, 

32-bit (Recommended)
•	 Software: .NET  framework 4.0 is required to run ComicRack 

0.9.122 and higher, Ghostscript 9 or later (optional) is needed for 
complete PDF support.

ComicRack is multilingual, with most language packs provided & maintained by its active community. 
The latest release of ComicRack always contains all language packs in the setup.  ComicRack is available in 
the following languages:
•	 English
•	 German
•	 Czezh
•	 Italian
•	 Spanish
•	 French

•	 Dutch
•	 Polish
•	 Japanese
•	 Greek
•	 Portugese
•	 Finnish

•	 Slovak
•	 Chinese
•	 Hungarian
•	 Turkish
•	 Russian
•	 Croatian

What is ComicRack?

Languages

System Requirements

ComicRack is the best eComic reader and manager 
for Windows computers. It is an all-in-one solution 
to read and manage your comic book library. It is 
actively maintained, has a strong user base and is 
FREE. 

ComicRack uses Comic Book Archive files, which 
have the extension .CBR or .CBZ and are simply 
renamed RAR or ZIP files, respectively. Apart from 
the standard CBR & CBZ formats, ComicRack sup-
ports various other file formats also including PDF,  
CB7(7z), CBT(TAR), DJVU, and may add further for-
mats in the future.
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THE READER
Read your comic books the way you 
want: Fast navigation, auto scrolling, 
auto rotation, dynamic zooming, au-

tomatic page fitting, magnifier, manga 
mode, full screen reading, dual screen 

support, multi-tab interface.

PAGES
Edit eComic pages, rotate them to your 
needs, change the reading order or add 

additional information.

THE LIBRARY
The powerful integrated library allows 

you to bring your whole collection to life. 
With different ways to group, sort and 

present all the data of your comic books, 
it helps you rediscover your hidden 

treasures.

CONVERSION
ComicRack can batch convert your 

comic books to all important formats (in-
cluding PDF). And all this is done in the 
background while you keep on reading.

INFO
ComicRack allows you to edit and show 
the information of your comic books. You 

can even change the color and sharp-
ness of comic pages.

CONFIGURABLE
ComicRack can be adapted to your 
needs. Optimize page display, share 
your library in your local network or 
change the user interface language.

Feature Overview
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SHARING
Using the network sharing functionality of 
ComicRack, you can open the shared li-
brary of other ComicRack users over the 
internet, and share your own library or 

database with them.

RATINGS
You can assign ratings to any comic 

book by simply clicking &/or dragging on 
the stars. ComicRack supports ratings 

on a scale of 1 to 5, with 0.1 increments. 
You can even enter average ratings from 

other reviewers as community ratings.

ADD-ONS
ComicRack is expendable with add-ons 
(called scripts) that enhance its function-
ality. With scripts, you can batch process 

books in ComicRack to accomplish a 
number of tedious manual tasks with just 

the click of a button. 

BOOKMARKS
Bookmark your comic books at any (and 
any number of) pages that you wish. You 
can use these as ‘jump-points’ for chap-
ters in a book, and for the next comic in 

a multi-comic archive.

COLLECTOR
ComicRack supports ‘Fileless’ comic 
entries into the database. This way 

ComicRack can be used as a ‘paper’ 
comic database management tool.

SYNC
ComicRack for Windows can synchro-
nize your comics and reading lists with 
ComicRack for iOS/Android over WiFi. 
Your synchronized comics will also be 
converted and optimized to reduce the 

space required on your device.

Feature Overview...
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eComics are basically archives of individual page images and usually have the extension .CBR or .CBZ. eComics 
are thus defined as RAR/ZIP/7z files containing JPG, BMP, PNG, or GIF images, with the extension changed to 
CBR/CBZ/CB7 respectively. 

The recommended format is CBZ or CB7, as ZIP/7z are freely available formats while RAR is owned by RarLabs. 
They have released the unRAR capabilities but not the RAR. So, programmers can write software that reads 
RAR archives (.CBR files) for free, but they can’t write software that creates or edits those files, without paying 
a license fee. Thus, the ComicInfo.xml file is changed/added only for CBZ and CB7 eComics, while for all other 
archive formats (including CBR), it is not touched.

ComicRack organizes eComics by storing metadata as XML snippets (either as part of the big 
library file ComicDB.xml) or as single small files (called Comicinfo.xml) into eComics. As eCom-
ics can have a variety of formats (PDF, CBZ, CBR, CB7, CBT), the ability to save metadata differs:
•	 PDF: No archive at all, no place for ComicInfo.xml or any custom metadata.
•	 CBR: Rar format can not be written (proprietary)
•	 CBZ: ComicInfo.xml is updated
•	 CB7: ComicInfo.xml is updated
•	 CBT: “Streaming” archive, no update because of performance issues.

Metadata for all eComics (of any 
format) that are in your ComicRack 
library, is stored in the database file 
(ComicDB.xml), so you can easily 
backup/restore their metadata. In 
case of CBZ (also in CB7, but not 
in normal zip or 7z) files, Comic-
Rack also stores metadata as the 
Comicinfo.xml file within these file 
formats. Once the Comicinfo.xml 
file is stored in CBZ or CB7 files, the 
metadata in these file formats will 
stay preserved, no matter wherever 
or how many times you transfer 
them. However, upon transfer, 
you will lose non-comic metadata 

information: last page read, current 
page, tags, rating, read percentage, 
opened count, added/opened date 
etc.

Technically you can retrieve meta-
data from CBRs as well, since the 
metadata is also stored in the 
secondary stream of a CBR eComic. 
This means that as long as you don’t 
move the eComic to a non-NTFS 
partition or burn it to a CD or some-
thing, you will be able to retrieve 
metadata from CBRs also. This also 
implies that in case of CBR files, the 
metadata is lost if you transfer the 

file to another computer. However, 
its metadata (or any file format, for 
that matter) can be saved by back-
ing up the database (ComicDB.xml) 
from the Preferences dialog. 

Backing up the database saves 
absolutely everything, including the 
non-comic metadata that is not pre-
served in the Comicinfo.xml file. For 
more information, see the section 
on Database Backup.

Metadata Tips

eComics: Basic Facts



Are you ready to expe-
rience ComicRack? In 
this chapter, you learn 
the basics of installing 
and getting started. 
Come on in!

Chapter 02: Getting Started

Installation� 7
First Run� 8
Getting it to work� 9
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1 2 3

5a4

Installation

Choose the folder in which to install ComicRack. 
The default location is: 

C:/Program Files/ComicRack

Download the latest ComicRack setup file from the 
ComicRack download page. Double-click the setup 

file to open the installation wizard. Click Next to 
continue.

Read the license agreement, and/or click I agree 
to continue. 

Now you can see the description of the compo-
nents by positioning your mouse over them. If you 

wish, you can uncheck (not recommended) the 
components that you don’t wish to install.

If .NET framework 4 is not already installed on 
your system, the ComicRack installer will offer to 
download it from the internet. Click yes when the 

ComicRack installer prompts you.

5c 6 7

Accept the .NET license terms and let it install.

Just after the .NET framework installation com-
pletes, a dialog box appears, asking for an immedi-

ate system restart. Click Restart Later.

Let ComicRack complete its installation. During 
installation, ComicRack optimizes itself for your 

system.

Click Finish to complete the installation. If you had 
instaled .Net in step 5 above, manually restart your 

system before running ComicRack.

5b

Installing ComicRack is a very simple process. Just follow the step-by-step instructions below to get ComicRack 
working on your system. The steps below depict the ComicRack installation on a PC running Windows 8. If you 
have a different (supported) operating system, the screens may appear slightly different.

http://comicrack.cyolito.com/downloads
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First Run

Double-click the ComicRack icon to open the program. It can be 
found on the desktop or on the Start Screen in Windows 8 or un-
der All Programs in the Windows Start Menu of Windows 7. You 

will be greeted with the ComicRack splash screen. 

A dialog may open, requesting you to Donate 
to ComicRack if you wish. Once you have 
donated, enter your email address. Click 

Validate, and wait for a moment. The Support 
dialog shall not bother you again. Even if you 
decide not to donate, ComicRack is fully func-

tional. In this case, click Skip for now. 

Security Alert
On some systems,  a Windows Security 

Alert may pop-up, indicating that 
Windows Firewall has blocked some 
features of ComicRack. You may check 
all options and safely click the Allow 
access button. This is a once-only step 
and won’t be required every time you 
start ComicRack.

This is the Sidebar.
Here you see a number 

of quick access lists, 
akin to playlists in a 

music player. You will 
later learn to make your 

own lists.

This is the Reader.
It shows the book currently 

being read. When ComicRack 
opens for the first time, you are 
greeted with the Quick Manual.

This is the Browser.
Here you will see the books 

that you add to your ComicRack 
library. You can double-click any 
book here to open it for reading 

in the Reader above.

Reading the Latest ComicRack News is the easiest & fastest way to keep in 
touch with all the latest updates to ComicRack. You can also enable the Check 
for news on startup option to open the news dialog every time ComicRack 
starts. This way you’ll never catch an update late!

ComicRack News!

As you are going to start ComicRack for the first time, we would like to welcome you to the ComicRack commu-
nity.  Wishing you a lifetime of comics, with a little help from the most complete and yet incredibly easy software 
that you have just successfully installed. So, come on, let’s start ComicRack!
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Opening your first comic book with 
ComicRack is the quickest way to get 
started! There are a number of ways to 
open books with ComicRack:

•	 From the Tools menu at the far end, 
click Open Book.

•	 From the Main menu at the top of 
the window, click the File menu and 
then click Open File.

•	 Double-clicking any supported comic 
book archive in windows explorer 
will launch that file with ComicRack.

•	 Right-clicking any supported comic 
book archive in Windows Explorer and selecting Open with ComicRack.

You can also drag and drop your books into ComicRack to read them or to add them 
to the ComicRack library:

•	 From an explorer window, select a book. You can even select a batch of books. 
•	 Drag & drop it over the Reader window (if you want to read it) or the Browser 

window (if you want to add it to the library). Learn more about these windows 
& the user interface of ComicRack in the next chapter.

Adding your comic book collection to ComicRack is the first step in managing/
organizing your ever expanding comic collection. Here is a quick startup on how 
to start a new comic book library with ComicRack:

1.	 From the main menu at the top of the window, click File and then click Add 
Folder to Library.

2.	 Browse to where your comics are. 
Select your comic book folder, and 
click Ok. 

3.	 ComicRack will scan the folder 
(and its subfolders) and add all 
books to the Library.

These steps may have to be repeated if 
you have your books in more than one 
folder. The next time you add a book 
to one of the added folders, you may 
click the Scan book folders button from the file menu, or simply restart Comic-
Rack, and the newly added files will be displayed in your ComicRack library. More 
advanced features of the library shall be discussed in the forthcoming chapters.

Getting it to work...

with Ghostcript
Out of the box, ComicRack has very 

limited support for PDF files. Basically it 
tries to get all the images in it and displays 
them. Of course, this works for most book 
PDFs but not for eBooks which also contain 
a lot of text. However, you can convert 
ComicRack to a full blown, fully compli-
ant PDF reader and have the advantage of 
all the built in library functions (cover, page 
thumbnails and previews, database etc.)

Enter Ghostscript
Ghostscript is 

a suite of software 
based on an inter-
preter for Adobe Sys-
tems’ PostScript and 
Portable Document 
Format (PDF) page 
description languages.

You simply have 
to download the official ghostscript release and 
install it on your system. Make sure to install 
the correct version. If you run ComicRack 
as 32 bit, you must install the 32 bit version 
of ghostscript (the 32-bit or 64-bit info can 
be found in the lower right-hand corner 
of the ComicRack splash screen, or in the 
About section of the Help menu). After this, 
ComicRack will automatically use it and 
display PDFs as nicely as Adobe Reader.

PDF Files
reading

Before Ghostscript After Ghostscript

Starting a new library

http://pages.cs.wisc.edu/~ghost/


Chapter 03: User Interface
Getting familiar 
with the interface and 
terminologies of 
ComicRack will serve 
as a primer for later 
understanding the 
myriad functionality 
ComicRack has to 
offer. 

Main Window� 11
Docking Grips� 12
Toolbars & Tab-Bars� 13
Status Bar� 14
Menus� 15
State Indicators� 16
Background Tasks� 17
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ComicRack broadly consists of 2 main components, the Reader window and the Browser window. You manage 
your comic books in the Browser, and you read them in the Reader. The ComicRack Reader and Browser are sup-
plemented by their respective toolbars and tab-bars. The Browser is supported by the Sidebar, which carries the 
library, plus all the reading lists. At the top of the ComicRack window is the Main Menu (which auto-hides when 
a comic book is opened), and at the bottom lies the Status Bar.

Main Menu

Browser Window

Sidebar

Reader WindowReader Tab-bar

Sidebar Toolbar

Browser Tab-bar

Reader Toolbar

Browser Toolbar

Status Bar

Main Window

This chapter is essential for understanding the terminology used to describe the various parts of ComicRack. Take 
some time to familiarize yourself with the components. Shown below is the default interface for ComicRack:

1

2
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In its default layout, ComicRack contains as many as 3 ‘hidden’ or ‘optional’ panels. These can be identified by 
noticing the dotted extenders known as Docking Grips. Clicking on these docking grips toggles off/on the 3 op-
tional panels, viz. Search Browser, Favorites & Small Preview. Apart from these, there are 3 more docking grips 
that assist in changing the layout of the ComicRack window contents. The locations and names of all the docking 
grips are tabulated below:

Location Name

1 Between the Browser Toolbar above and the Browser window below Search Browser Docking Grip

2 Between the Sidebar Toolbar above and the Sidebar below Favorites Docking Grip

3 Between the Sidebar above and the Status bar below Small Preview Docking Grip

4 Between the Reader Window above and the Browser Tab Bar below Browser Docking Grip

5 Between the Sidebar on the left and the Reader window on the right Sidebar Docking Grip

6 Between the Browser window above and the Status bar below Info Panel Docking Grip

Favorites Panel Search Browser

Info PanelSmall Preview

Docking Grips

12

3

5

4

6

4

IN A NUTSHELL

Technically speaking, the Sidebar also is an optional panel, yet it is active in the default ComicRack setup. This is 
due to the essential functionality of the Sidebar (discussed in forthcoming chapters). Please also note that the Info 
Panel docking grip is not seen in the default setup. It shall be discussed later.

The essential Sidebar!
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The Comic Reader is the area where the open comic books are displayed. Just above the Reader window is the Read-
er Tab-Bar on the left,  and the Reader Toolbar on the right. The Reader Tab-Bar shows the tabs for currently opened 
comic books. Scrolling anywhere over the reader tab-bar switches its tabs. It continues into the Reader Toolbar, which 
contains several buttons and menus required for customizing how comic books are displayed in the Reader.

The Browser Tab-Bar contains tabs for the Library Browser, Folders Browser and Pages Browser, which are all integrated 
with the Sidebar Toolbar and the Browser Toolbar. The Sidebar folders & lists can be opened in a new tab here. Shared li-
braries also show up here in their own tabs. The Library and Folders tabs open  up their respective content in the Sidebar, 
while the Pages Tab uses the entire Browser window to display details regarding the pages of an open comic book. Please 
note that scrolling anywhere over the tab bar switches its tabs.

The Sidebar toolbar contains the icons required 
for working with the sidebar. The content of the 
Sidebar Toolbar changes with respect to the tab 
open in the Browser Tab Bar.

The Browser toolbar contains a number of options for viewing a vari-
ety of comic layout styles in the Browser. The content of the Browser 
Toolbar changes with respect to the tab open in the Browser Tab Bar.

Toolbars & tab-bars

Reader Tab-bar

Sidebar Toolbar

Reader Toolbar

Browser Toolbar

Browser Tab-bar
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Total comic books displayed in the Browser/ Total Size

Current Page of the open 
comic bookNumber of selected comic books / Size/File Path Display resize slider

Caption of the opened 
comic book Server Statistics

Page count of the 
opened comic book

Pending Background Tasks Indicator

Status Bar

At the very left of the Status Bar, the total 
number (and size) of comic books displayed 
in the Browser is seen. This number indicates 
the number of comic books present in the list 
selected in the sidebar. The file path of the cur-
rently selected book is also seen. The Library 
list is the default, and reflects your entire com-
ic book collection archived with ComicRack.

This is the number (and size) of the comic books 
currently selected in the Browser window. For 
some users, this might be the quickest way to find 
out the size of a particular comic book, or a group 
of many comic books.

This is the current 
page number of the 
open comic book 

Left to the resize slider is the 
page count of the opened comic 
book, followed by the current 

page number of the open comic 
book and the caption of the 
opened comic book, in that 

order.

At the right end of the 
Status Bar, the Display 
resize slider is present. 
This is used when you 

wish to increase or 
decrease the size of the 
comic books view in the 

Browser window. The 
resize slider can be 

dragged to the right to 
increase the thumbnail 
or the tile size, and, in 

case of the details view, 
the row size.

If you are sharing your 
library over the network, 
you will see a round icon 
at the extreme right of 

the Status Bar; this is the 
Server Statistics button, 
clicking which will open 

the Server Statistics 
tab of the Tasks Dialog 

showing displaying all the 
detailed server statistics 
for your shared library.

This is the Pending Back-
ground Tasks Indicator, that 

shows an animated icon 
whenever info data from files is 
being read, or web comics are 

being updated. Clicking it brings 
on the Tasks Dialog showing 

the Background Tasks tab. It is 
described in detail later in this 

chapter.

The ComicRack Status Bar is present at the very bottom of the ComicRack window. It displays important informa-
tion about your comic books. 

The ComicRack main menu gets automatically hidden when any comic is opened in the read-

er window. It can be toggled on/off using the Alt key or using the Show main menu option 

from the Tools menu. Please note that for this feature to work even when no comic book is 

open, you should turn off the show main menu if no comic book is open option from the 

Preferences dialog (Behavior tab -> Application section).

How do I hide the Main menu?FAQ
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Menus

The File menu can be used for 
opening or closing comic books, 

creating a new tab, organising and 
updating the library folders and 
files, fileless comic book entries, 

opening remote libraries, accessing 
the history, and to exit or restart.

The Browse menu helps you toggle 
ComicRack components on/off  

shift back and forth the comic lists
and browse / edit workspaces and 

list layouts.

The Display menu contains the 
Comic Display Settings dialog, page 

customization options (Layout, 
zoom, rotation), and user interface 

customization options. 
The Page Layout options can also 

be accessed from the Reader 
Toolbar.

From the Edit menu, you can open 
the comic book Info dialog, Undo / 
Redo actions, change comic book 
page types, rate and bookmark 

comics, copy/export pages, refresh 
ComicRack, and open the Prefer-

ences dialog.

From the Read menu you can 
shift between comic book pages, 
between individual comic books 

and between tabs, and options for 
Autoscrolling.

The Help menu contains important 
links to the ComicRack forum and 
homepage. The ComicRack docu-
mentation links to the wiki page. 
You can use the Choose Help Sys-
tem sub-menu to make either the 

Online ComicRack Manual (recom-
mended) or the Wiki the default 
help system on your ComicRack.

The ComicRack Main menu contains a number of self-explanatory menus. Each menu has a number of sections, 
containing several functions. All of these functions have been described in relevant chapters. Here is a brief 
overview of these menus. 

https://sites.google.com/site/comicrackmanual/home
http://comicrack.cyolito.com/documentation/wiki
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Green: The comic book is currently open in the reader. If no comic book is open, 
the green star will not be seen.
Orange: Data is pending to be written to the Comicinfo.xml file in the comic book 
archive. This includes changes to the metadata, information on the page images, 
changes in comic book attributes (like file size and file modified time). Updating 
your comic book files makes the orange stars disappear. 
Violet: A fileless comic book. These are simply ComicRack database entries for 
comic books which are not actually present on the hard disc.

STARS
Red: The Web comic has been updated with new pages. The number is the num-
ber of new pages. Once the new pages are read, the red stars disappear.

State Indicators

RIBBONS
The green ribbon indicates the last page 
read in a comic book. The yellow ribbon 
is the current page open in the comic 
book. If the current page being read is 
earlier than the last page ever opened, 
the yellow ribbon scrolls down as the 
comic book pages are read, till the green 
ribbon is reached. From there on, the 
green ribbon takes over till the end of the 
comic book.

COVER BROWSER
The cover browser is represented by the the little -/+ 
signs over the  comic book thumbnails & tiles in the 
browser. This indicates the number of pages in the 
comic book marked as front cover. It can be used as 
a visual indicator to identify comic books with variant 
covers, browse through the covers, and choose the 
cover to be displayed as the thumbnail/tile.

RATINGS
You can rate your comic books in ComicRack on a scale of 0 to 5, with 
0.1 increments. Based on your preference, the ratings on the comic book 
thumbnails can be displayed either in a numerical manner (at the bot-
tom right of the thumbnail), or as rating stars (below the thumbnail).The 
community ratings are blue-colored, while ratings assigned by you are 
yellow-colored.

-1/2+

Total number 
of front covers 
in the comic 
book

Click on the + sign to browse forward the 
front covers. Click on the - sign to move 
back. Please note that once you reach 
the last front cover, clicking on the + sign 
will move you on to the first cover.

Cover number 
currently select-
ed for display as 
thumbnail

Blue: The comic book in the current list that was last opened in the reader.
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The Pending Background Tasks Indicators also integrate with the Windows taskbar, providing you at-a-glance 
information about the current status of ComicRack just by looking at the taskbar.

Export
When the export comic 
books function is used to 
convert comic books from 
one format to another, this 
indicator will be seen in the 
status bar.

Thumbnails
This is an indicator depicting that ComicRack is 
currently getting info and creating thumbnails for 
the comic books  being viewed in the browser. It 
also appears when you update Web Comics over 
the internet.

Write
This indicates that ComicRack is 
writing information to the comic 
book files

Scan 
This indicates that Comic-
Rack is currently running a 
scan on your library folders, 
searching for new comic 
books.

Background Tasks

If there are any currently under-process assignments (called Pending Tasks), then corresponding animated icons 
are displayed in the Status Bar. These are the Pending Background Tasks Indicators. Double-clicking any of these 
opens the Pending Background Tasks dialog. Currently, there are 4 types of pending background tasks indicators, 
any or all of which can be seen running in the status bar, depending on the state of the pending tasks.
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The Sidebar is an essential component of the Browser, and changes its content according 
to the tab open in the Browser Tab Bar. The Search Browser, Favorites panel, and the 
Small Preview are the 3 optional panels of the Browser, and can be toggled off/on using 
their respective Docking Grips.

Introduction

The position of the Browser in the 
ComicRack window can be changed to 
suit the user’s choice. The Dock menu 
present on the extreme right of the 
Browser tab-bar can be used to place 
(dock) the Browser to the left, right or 
bottom position in the ComicRack win-
dow. The Browser docked at the bottom 
is the default setting.

One important setting is the Dock Fill op-
tion, which unifies the Browser tab-bar with 
the Reader tab-bar and the Reader Toolbar. 
In this setting, comic books open on this 
Unified Tab bar. 

Info Panel Right
The Dock menu also contains the 

Info Panel right option. You can use this 
option to dock the Info Panel (docked at 
bottom of the browser by default) to the 
right side of the browser. The Info Panel is 
an optional panel that can be used by various 
scripts to display customized info. The Info 
panel opens in the browser, but without any 
complementary scripts enabled, it doesn’t 
show up. To know more about the Info 
panel, see the corresponding section at the 
end of this chapter.

DOCKING
the browser

The Browser window is often referred to as the Library Browser,  Folders Browser or 
Pages Browser, depending on which tab is open in the Library Tab Bar.  Here you see 
the Folders Browser window.

There are 2 tabs in the Browser Tab Bar, viz. Library and Folders. The Pages tab appears 
only when a comic is open in the Reader window. Out of these, the Library and the 
Folders tabs are integrated with the sidebar, while the Pages tab does not contain the 
Sidebar. 

The Browser is the section of ComicRack that helps you manage / organize / browse your comic book collection. 
All (or selected) comic books are displayed in the Browser window in the form of thumbnails, tiles, or details 
view. The Browser window is ably supported by the Browser Toolbar and the Browser Tab bar. 
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Views

The thumbnails  view is the most commonly used view, 
and is enabled by default. Double-clicking on a (unstacked) 
thumbnail opens up its comic book in the reader. It is 
possible to increase or decrease the size of the comic 
book view by using the comic book display resize slider 
present on the status bar, or by holding CTRL and scroll-
ing the mouse wheel.

The tiles  view is relatively more informative than the 
thumbnails view. Double-clicking on a (unstacked) tile 
opens up its comic book in the reader.

The details view is the most informative 
view. Double-clicking on a comic book 
column in the details view opens up its 
comic book in the reader.  You can not 
stack comic books in the details view. 
The comic books of a group are ar-
ranged by your specified metadata field, 
seen as a small arrow on the column 
heading.  A single-click on this arranging 

column-head toggles the order from de-
scending to ascending (notable from the 
direction of the arrow: pointing down-
wards or upwards, respectively). You can 
change the column positions by a simple 
drag  and drop using the mouse.  Right-
clicking the header of any column in the 
details view brings about the details con-
text menu.

The new expanded cover view in detailed 
mode can be turned on by moving the 
cover column to the first or last column.

We will learn more about the details 
view on the next page.

The Views button helps choose how and what comic books are displayed. Basically, 
you get to choose from 3 different views: thumbnails, tiles & details. Click the Views 
button to toggle between the thumbnails, tiles & details views. Clicking the small 
downward-pointing arrow beside the views button opens up the views menu.
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Date/Time FormatRatingIcons

Spin Buttons Gap Information Checkboxes

ComicRack supports long/short/relative 
time formats for date-related metadata fields, 

specially the File Modified field. Just hover 
your mouse at the field header to get a drop-

down arrow, clicking which reveals the options.

Metadata fields that can have a Yes/No value 
are displayed as checkboxes in the details 

view. These include fields like Series Complete, 
Read, B&W, etc. You can simply click at them 

to toggle yes/no. You can also select more than 
1 books, and use the checkbox fields in a single 

go. 

Spin buttons are displayed alongside metadata 
fields that have a numeric value. Example of 
these fields include Number, Read, etc. You 
can simply click at the up/down spinners to 

increase/decrease the respective values. Please 
note that the spin buttons are seen only on the 

activated (clicked) rows.

The Gap Information field in the details view 
shows visual information about missing issues 

of a series. 

gap starts here

gap ends here

gap both before & after this issue

The now-familiar rating stars in the 
details view allow a quick assignment 

of the rating by clicking at them.

ComicRack supports display of a variety of 
icons for Publisher, Imprint, Format and Age 

Rating categories. All the icons for a particular 
book are visible in its details view.

The Details View
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Click to close the Stack
Navigate comic books using 

the Stack toolbarStack Title

The Stacks Layout

Double-clicking the stack 
has opened up the comic 
books. The stacks toolbar 

is visible at the top. As 
we had stacked the comic 
books by series, the stack 
title (in the middle) dis-
plays the series name.

Viewing comic books as 
thumbnails, stacked by 

series

Stacking implies placing books one above the other in the ComicRack browser. To stack books in Comi-
cRack, just click the Stack button on the Browser toolbar, and choose the metadata field that you wish 
to use as the criterion for stacking your books.

Stacking comic books in the thumbnail & tiles views brings forth few additional features. Double-click-
ing on a stack opens up its individual comic books in the browser, and additionally the Stacks toolbar 
appears on top of the browser window. Stacks display the average (community) rating of the stack. 
Bookmarks on stack display how many of the books in the stack have been read.

•	 Use the Set Custom Stack Thumbnail option from the Browser Con-
text Menu to set any picture file of your choice as the stack cover. 

•	 Open up the stack by double-clicking it. Now, right-click any comic 
book to get the browser context menu (see next page), with an ad-
ditional option: Set as top of stack. You can use this option to select 
any comic book (from all the comic books constituting the stack) to 
appear as the stack cover.

Stack Customization
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The Views button provides an option 
to find & remove duplicate issues that 
you may have accumulated over time. 
There are a number of metadata values 
needed for comics to be matched; most 
importantly, Series Name, Issue Num-
ber and Volume. Note that “Superman 
#1” and “Superman V1 #1” would not 
match, nor would “Superman V1 #1” and 
“Superman V2 #1”.

To use this feature, from the Views but-
ton, select Show Duplicates. After a slight 
delay (dependent on the total number of 
issues in the library, folder or list that this fea-
ture is run against), all applicable duplicates 
will display, allowing the user to make any 
changes or deletions desired.

DUPLICATES
removing

Browser Menus

Context Menu

Layout Menu

Right-clicking in any empty space in the browser 
brings about the Layout  menu that carries over 
most of the features of the browser toolbar. This 
includes the view, arrange, group and stack menus. 

Right-clicking any comic book in the 
browser brings about the browser con-
text  menu. Many of the submenus 
share an overlap with the main menu. 
Features like exporting comic books, 
copying and pasting data, and lists-
related options are discussed in the 
relevant sections. While most options 
are self-explanatory, some important 
features are outlined below:

•	 Open comics in the Reader 
•	 Mark comic books as Read or Unread
•	 Rate comics
•	 Copy, paste metadata from one comic to 

other
•	 Clear Meatadata
•	 Find comic books with similar metadata
•	 Open comic book with Windows Explorer
•	 Use any comic book cover as  background 

image for a list open in the browser
•	 Remove (or delete) comics

Did you know?

Grouping and stacking supports combining up to three criteria. Combining is done by 
clicking the additional criteria while pressing the Ctrl Key. Such combinations bring on an 
endless possibilities of grouping & stacking your comics in the ComicRack library!

Multi-grouping



Chapter 4: Browser24ComicRack Manual | 6th Edition

Library Browser

Library Browser

Library folder

Reading Lists

Sidebar button List Layout Quick Search

Views

Duplicate Current List

Click to toggle the 
Sidebar off/on

Move through the 
succession of lists 
recently browsed

Arrange the comic 
book viewing options

Here you see the comics Grouped by Publisher, 
Stacked by Series, and Arranged by Number.

Undo or Redo the 
last operation per-

formed in ComicRack

Search your library 
based on keywords, 
series, writer, art-
ists, descriptive, or 
filename. The quick 
search box is an on-
the-fly filtering tool: 
simply start typing, 
and the Browser 

window will display 
(as you type) all the 
items with matching 
description fields. 

View as thumbnails, 
tiles, or details. Op-
tion to filter comic 

books based on read 
state, and duplicates.

Undo / Redo

Previous / Next

Name of the metadata field 
used to group the comic books

Group
StackArrange

Grouping, Stacking and arranging (based 

on desired metadata) comic books 
help in customizing the view as per 
your choice. Different permutations 
and combinations of these 3 options 
provide a variety of environments for 
managing comic books. The grouping 
metadata field is seen as a heading with 
a disclosure triangle that can be used to 

toggle on/off its individual comic books. 

Just note the direction of the arrows 
on the group / arrange buttons. A 

downward-pointing (default) arrow 
indicates alphabetical order (from 
A to Z). You just need to simply 

click on the button and the arrow 
will reverse its direction, giving 
you the reverse alphabetical ar-

rangement (from Z to A). 

Group/Arrange in Reverse Order

The Library tab is the section of ComicRack that allows the user to interact with archived comic books via the 
Browser window (referred to as the Library Browser when the Library tab is open). Adding comic books to the 
ComicRack library gives you the advantage of storing metadata, which then can be used for organizing your 
comic book collection. Using the Library tab, you can view in the Browser window either your entire collection 
(via the Library folder in the sidebar), or selected groups of comics (via reading lists in the sidebar).



25 Chapter 4: BrowserComicRack Manual | 6th Edition

Library folder

Reading Lists

Sidebar Context Menu

Sidebar Toolbar

Live 
Counters

Arranging files and folders in the Sidebar

Temporary Lists

The Sidebar contains the 
Library folder, the default 

(albeit virtual) Comic-
Rack folder that contains 
your entire comic book 
collection archived with 

ComicRack.

The Sidebar is also needed 
for creating, organising, 

and accessing read-
ing lists. 

These are visual indicators for 
new/unread/total books in a 

list. The Red gauge represents  
new books added in the past 

10 days. The yellow gauge 
indicates the unread book 

count, while green one shows 
the total book count.

Arrange lists within a folder in alphabeti-
cal order 

You can make folders within folders for 
arranging your lists . 

Any number of lists can be kept within a 
folder, and can be dragged up or down, 

both within a folder and from one folder 
to another.

Lists or folders can be placed at any level 
of hierarchy

Lists can be copied and pasted from one 
folder to another within the sidebar

Export Reading list saves a  reading list 
on the desktop or any folder of your 

computer. You can then transfer it to use 
it on another system or share it with your 

friends, who can use the Import Read-
ing list option to add it to their Comic-

Rack sidebar

Double-clicking any read-
ing list from windows ex-
plorer opens it directly in 
ComicRack. This is made 
possible by means of the 
Temporary Lists folder. It 
can also be used to store 

experimental reading lists, 
as any list kept here is 

deleted on the next run of 
ComicRack.

Right-clicking on any 
folder or list in the sidebar 
brings up the Sidebar con-

text menu. It contains a 
number of options, many 
of which share an overlap 
with the Sidebar Toolbar 
and are covered in the 

next section.

Sidebar

This opens the Favorites panel at the top of 
the Sidebar. Select any item in the sidebar, 
right-click, and you will be able to add it to 

the Favorites panel.

This expands/collapses all the 
lists and the root folders in the 

sidebar with a single click.

Creates a new folder to 
organize your lists. Lists can be 
dragged and dropped into the 

sidebar folders.

Open in new
window/tab

Create a new list

The Library and the Folders tabs of the Browser Tab Bar are integrated with the sidebar. Just like the browser, 
the Sidebar changes its content (Library Sidebar or Folders Sidebar) according to the tab open in the Browser 
Tab Bar. As the Library view is the default, we will, from here on,  refer the Library Sidebar as simply the Sidebar.



Chapter 4: Browser26ComicRack Manual | 6th Edition

Folders Sidebar

Favorites

Sidebar Toolbar Browser Toolbar

Folders BrowserSmall Preview

Search Browser

Viewing selected folders 
as shortcuts for quick 

access.
Just right-click a folder in 

the sidebar, and select 
Add Folders to Favorites

Clicking on any folder displays 
its comic book content in the 

Folders Browser. 
Right-clicking  any folder 
opens the context menu

Essentially the same as the library browser, the 
only difference is that it displays the content of a 
particular folder on your system. Can be grouped, 

stacked, arranged in the same way as Library 
Browser

This is an optional panel that display the comic 
book selected in the Browser, whether opened 

or not, without changing its read state and book-
marks.

Folders Browser

The Include all subfolders icon is useful for toggling off and 

on the subfolders of a folder selected in the Sidebar, or of a 

favorite folder. To use it, click on a folder in the Sidebar, or in 

the favorites panel. Next, click on the Include all subfolders 

icon. All subfolders shall now display in the library. Clicking on 

the icon again will toggle the subfolders off. 

How do I exclude comic books in subfolders of a favorite 

folder from being displayed by default in the browser ?FAQ

The Folders tab allows you to browse your computer for comic book folders in a Windows Explorer-like fashion. 
Selecting a folder opens the contained comic books in the browser (referred to as the Folders Browser when the 
Folders tab is open). Similar to the Library browser, the Folders browser is integrated with the sidebar, and can 
display a Favorites panel above, and a  Small Preview panel below. The Search Browser is also available.
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Page Context Menu

Page Filter Menu

Views

Pages Browser Context Menu

The Page Filter menu can 
be used to toggle types of 

pages on and off. These 
changes also apply to 

any other comics as well 
as the reader view. For 

example you can uncheck 
the Advertisement setting 
and you will never see a 

page marked as Advertise-
ment as you’re reading a 

comic. 

Right-clicking on any page in 
the Pages Browser invokes 

the Page Context Menu. This 
contains options for changing 

Page Type, Page Rotation, 
Adding / removing Bookmarks, 

reordering pages within a 
comic book, copying page(s) 

to another location, and mark-
ing pages as deleted (so that 
they do not show anymore in 

ComicRack).

Just like the Library Browser 
and the Folders Browser, op-
tions for viewing thumbnails 
/ tiles / details view are there 
in the Pages Browser too. The 

only difference is that here 
individual comic book pages are 

displayed in the Browser.

Right-clicking on any empty space in the Pages Browser 
invokes the Pages Browser Context Menu. This contains 

the view / arrange / group options analogous to the Pages 
Browser Toolbar.

Please note that the Pages Browser Context Menu is dif-
ferent from the Page Context Menu.

Pages Browser

The Pages browser is the section of ComicRack that allows the display and organizing features for the pages of 
a comic book in the browser window. The Pages tab is visible only when a comic book is open. ComicRack pro-
vides labelling for individual pages of a comic book, as Front Cover, Story, Advertisement, Letters etc. The page 
type can be changed to suit your needs. Similar to the library browser, the pages browser also has the options for 
viewing, arranging and grouping comic book pages. It should be noted that, unlike the library and folders brows-
ers, the Pages Browser does not contain the Sidebar.
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Working with Pages

You can save page(s) as a single image file(s). To do so, right-click any page thumbnail in the pages browser 
and select the Copy Page option. You can now just paste the page anywhere in either windows explorer, or 
an image editor of your choice. Multiple pages can be similarly saved by selecting them individually using 
the Ctrl key, or selecting all pages via the Select All option. An alternate way to save pages is to simply to 
drag the page(s) to a location on your computer from the pages view.

Saving Pages

You can change the order of your comic book pages 

by simply clicking and dragging them to where you 

want them to be. A black line shows where it will 

be reinserted. You can also use the Move to Start or 

Move to End options in the right-click context menu 

for moving a page to the beginning or end of a comic 

book respectively. A Reset original order option is al-

ways there if you wish to undo these changes.

How do I reorder pages within a comic book ?FAQ

With ComicRack, you can save, delete, rotate and reorder individual pages of the comic book archives added to 
your library.

If you wish to delete some pages from a comic archive, ComicRack provides for 2 options:

Deleting Pages

1.	 Mark the pages as deleted, without actually removing the 
page(s) from the comic file. Once a page is marked as deleted, a 
red cross would be visible on the page, indicating that it has been 
marked as deleted and will not show while reading, while it is not 
actually removed from the comic book file. There are several ways 
to do this: 
•	 Change the page type to Deleted from the Page Type sub-

menu from the page context menu
•	 Press the Del button on the keyboard
•	 Choose Mark as deleted from the Page context menu. 

2.	 Actually delete the page from the comic. To do this, just fol-
low the steps outlined to mark the page(s) as deleted, and then 
export the book. You will learn more about exporting comics in a 
later chapter.
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Column 1

Column Header

Using metadata fields to filter the 
search results

Drop-down Menu

Column 2 Column 3

To quickly clear the filters 
in the Search Browser, 
simply click the column 
header, and it will revert 

to showing ‘all’. If you 
click on the header of 
the leftmost column, 

this won’t reset all the col-
umns; instead, it will now 
reflect the search results 
based on the new filters 

provided.

The drop-down menu of 
all the 3 columns contain 
the same metadata fields. 

The Search Browser 
provides more than 20 

commonly used metadata 
fields to filter your search 

results. As per your 
requirement, you can 

choose any combinations 
of them.

In the example shown, we have chosen 
the 3 columns as Publishers, Genres and 
Series. Clicking a Publisher will narrow 
down the Genre column to all comic 

books of the particular Genre; clicking 
a specific genre narrows down the third 
column to all the comic book series that 

have the selected genre. Finally, the 
comic book listing is narrowed down 
further once you click on a particular 

comic book.

The little exclamation (!) 
mark present next to the 
drop-down menu in each 
column is the Negation 

button. If you select this, 
all comic books that do 

NOT match the criteria are 
displayed.

Negation

Search Browser

•	 To select multiple fields in the Search Browser, just hold 
the Ctrl key and click on desired metadata fields. 

•	 To select a number of fields in continuity, you can hold 
the Shift key and click the first and the last fields; all 
fields in between the 2 clicked ones will be selected.

Select Multiple Fields

Short of using reading lists, the Search Browser offers one of the quickest ways to access a comic book or a set 
of comic books based on the metadata present. The Search Browser is present above the main Browser window. 
Please note that the default ComicRack layout has the Search Browser hidden. 
As the Search browser opens, a three-part pane will slide down, allowing you to narrow down the visible comic 
books by using three metadata fields. The drop-down menus can be chosen to display the comic book metadata 
attribute of your choice. Choosing a particular metadata attribute delimits the comic book search results in the 
Browser accordingly. 
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Optional Panels

FAVORITES
This small panel at the top of the Sidebar 

will display the folders or lists of your 
choice for quick access. To add a folder/
list to Favorites, right-click & choose the 
Add to Favorites option. You can have 
different sets of favorites items for the 

Library sidebar & the Folders sidebar at 
the same time. Right-click on any favorite 

item to refresh or delete it. 

INFO PANEL
The Info Panel is an optional panel that can be used by script authors to display customized info, for example open webpage from Web 

field of comic Info. The Info panel opens in the browser, but without any complementary scripts enabled, it doesn’t show up. To open 
the Info Panel, either use the Info Panel option in the Browse menu, or use the Shift+F9 keyboard combo, or click the Info Panel dock-

ing grip at the bottom of the browser window.

SMALL PREVIEW
This small panel at the bottom of the Sidebar will display the comic book selected in the 
Browser, whether opened or not, without changing its read state and bookmarks. You 

can use the mouse wheel in the small preview panel to scroll to the next/previous pages. 
Please note that the default ComicRack layout has the Small Preview hidden. To toggle 

the small preview on/off, either use the Browse menu or click the docking grip at the 
lower border of the sidebar.

Open the book 
in the Reader

Show one / two pages 
in the preview

Info Panel

Browser

Sidebar

First open the Preferences dialog & go to 
the Scripts tab. From the Available scripts 

section, enable the Web link script. Ad-
vanced users may also enable the Dummy 

Comic Info UI/HTML scripts. Click Ok & 
restart ComicRack.

In the browser, select any comic 
book with a valid web field. The 
Web link tab will show the page 
corresponding to the web ad-

dress of the comic book. You may 
browse that complete website 

through this page.

A basic knowledge of the preferences dialog & scripts is required to understand this panel, so we recommend that you first get 
acquainted with these above-mentioned sections, and then come back to the present page. Info Panel scripts are described in detail in 

the Scripts chapter. 
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Reader Tab Bar Reader ToolbarReader Window

Introduction

Clicking here takes you to 
the previous or next page, 
respectively. Clicking the 
small downward-pointing 
arrow opens up a drop-
down menu that has ad-

ditional options for going to 
the previous/next bookmark 

or book in the list.

Provides options for showing 
one or two pages at a time 
in the Reader window. You 
can also use the right to left 
mode for reading manga. 

Provides options for displaying 
book pages by fitting width/
height/all dimensions. 

Provides options 
for rotating the 
open book 90o,, 
180o, or 270o. 

The Magnify button 
in the Reader Toolbar 
contains options for 

controlling width, 
height, opacity and 
zoom of the magni-
fier, which is used to 

temporarily enlarge the 
desired page portion. 

At the end of the 
Reader Toolbar is the 
Tools menu, which is 
a completely reorgan-
ized and easier-to-use 
ComicRack menu, hav-
ing multiple important 
options from all over 
ComicRack in a single 

pane.

There are a number of ‘modes’ (detailed on the next page) in which the books can be displayed in the reader window: 
1.	 Default Mode (Showing the Reader, Browser, and the Sidebar)
2.	 Reader Mode (with the browser & sidebar closed) (F3) (Clicking on the docking grips between the Reader and the 

Browser toggle off/on the browser, thus achieving the same result)
3.	 Fillscreen Mode (with menus and toolbars)
4.	 Fullscreen Mode (F11) (no menus or toolbars)
5.	 Windowed Reader Mode (F12) (the Reader gets a window of its own)

Display Modes

The Reader window is the most important part of ComicRack, as this is where the book pages are ultimately dis-
played for onscreen reading.  Scrolling the mouse wheel moves the open page up or down, and scrolling beyond 
the end of the page opens the next page of the book. This is the simplest way of navigating the Reader.
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Double-clicking or pressing F11 or the Full Screen button 
(Reader Toolbar) in the reader window brings up View #2, 

while clicking the mouse or pressing F3 takes us to view #4.

This is seen after clicking the Full Screen button (Reader Toolbar) 
(or pressing F11 or double-clicking) in the Reader window of the 
default view #1 or clicking the mouse (or pressing F3) in View #3. 

This is seen after pressing F3 (or clicking the mouse) in the 
Reader window of view #2 or F11 (or double-clicking) in 

View #4. A single click or F3 again brings back view #2, while 
double-clicking or pressing F11 takes us to view #4.

This is seen after pressing F11 (or double-clicking) in view #3 
or pressing F3 (or a single click) in the Reader window of View 
#1. Pressing F11 (or double-clicking) again brings back view #3, 

while pressing F3 (or a mouse click) takes us to view #1. 

The Default Mode
displaying the browser and the sidebar, apart 

from the reader

The FillScreen Mode
in which the ComicRack window (with menus & 

toolbars) fills the entire desktop

The Reader Mode
With the browser and the sidebar closed, the complete 

space in the ComicRack  window goes to the Reader.

The FullScreen Mode
in which the reader (without any menus or tool-

bars) occupies the entire desktop

Reader Navigation

1 2

34

It is possible to quickly navigate between the 4 different modes using the mouse or the keyboard.
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When a number of books are open in the 
Reader, the Tab-Bar displays right and left 
buttons at its ends to navigate between 

them, and a drop-down menu at the end 
that contains a list of all the open books.

Right-clicking a tab brings up the 
tab context menu, which contains 

options for revealing the open 
book in the browser or in windows 

explorer. You can use the Close 
all but this option from the tab 
context menu to close all other 

books in one go.

Every tab contains its 
own close button that 
appears when the tab 

is selected. 

A single (left) click on the tab of 
the comic book currently being 

read, toggles between the Reader 
& the Browser.

Tabs can be dragged and dropped  
to change their position to any 

desired one on the Reader tab bar.

Double-clicking a book from the browser 
opens it in the current tab (whether empty 
or occupied by another book) in the reader 

tab bar. If you hold the Ctrl key while 
double-clicking, the book will open in a 

new tab. 

On hovering the mouse over the tab, an info 
box pops-up that contains the book caption, a 
brief plot of the book, format (ZIP/RAR), size 
and number of pages. At the bottom, it also 

displays the icons and age ratings for the book

Reader Tab-bar

The Reader Tab-bar is present over the top left of the Reader window. It continues into the Reader Toolbar. The 
Reader Tab-bar shows the currently opened books in a tabbed interface. When no book is open, it displays the 
Plus (+) tab. Clicking (either left-click or right-click) this tab adds new reader tabs. Double-clicking a book from 
the browser opens it in the current tab. Clicking on a selected tab toggles between the Browser and the Reader. 
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The open file button 
opens up a Windows 

Explorer dialog, through 
which you can browse 

and select any book for 
opening in the reader 

window.

Clicking the Browser 
button toggles the 
browser off / on.

Select a book and click 
the open button to read 
it in the reader window.

To open an book in the 
reader, double-click the 

book from any of the 
lists displayed in the 

quick open box.

Here you can see all 
the lists that are being 
displayed in the quick 
open box. Each list has 
a ‘disclosure triangle’ 
which allows you to 

hide or show the books 
in the list. 

Quick-Open Box

The Reader context menu is seen after right-click-
ing any page open in the Reader window. Most 
of the options present here share an overlap with 
other menus and toolbars in ComicRack, and are 
discussed in the relevant sections. Some impor-
tant sub-menus are discussed below: 
•	 Export Page: This allows you to save any page 

open in the reader window to any Windows 
Explorer folder. You can choose the page type 
from JPG/BMP/PNG/GIF/TIFF formats. 

•	 Copy Page: The Copy page function is also 
similar, allowing you to paste the copied page 
to windows explorer. It simply saves the page 
in its original format.

•	 Page Rotation: Changes selected page ro-
tation permanently in the book archive. 
So if some pages in your comic archive are 
scanned in a wrong horizontal/vertical posi-
tion, there is no need to extract images and 
rotate them in an external editor. 

•	 Minimal User Interface: Selecting this option 
hides the main menu, reader tab bar, reader 
toolbar and the status bar in the fullscreen 
view of the reader window.

Reader Context Menu

The Quick Open box can be seen inside the Reader window when no book is open. While the default ComicRack 
setup displays the No book is open message, once you add books to the ComicRack library, the Quick Open box 
appears in all its glory. It shows all the default reading lists present in ComicRack. You can set any reading list to 
be available in the Quick Open box. From every list, upto 10 books can be displayed here, depending on the last 
time read and added criteria.
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Overlays

The Navigation Overlay 
displays a filmstrip of all the 
pages of the currently open 

comic. Just hover your mouse 
over the lower border of the 

Reader window, and the navi-
gation overlay will slide up. By 
default, the navigation overlay 

is shown at the bottom of 
the reader window. The book 

pages can be viewed as a 
filmstrip here. Clicking on 

any page here opens it in the 
reader window. The mouse 

wheel can be used to browse 
the filmstrip back & forward. 

You also have the option from 
the Reader setup tab of the 
Preferences dialog for show-
ing the navigation overlay at 

the top.

The Current Page Overlay can 
be seen in the upper right 

corner of the reader window. 
It is visible only when the 

page in the reader window 
is changed. It displays the 

page number (along with the 
number of total pages). From 
the Reader setup tab of the 
Preferences dialog, the page 

name can also be displayed in 
this overlay.

Visible Page part Overlay dis-
plays the portion of the page 

currently visible on the screen 
with a thumbnail of the entire 

page currently open in the 
reader. You can turn off the 
visible page part overlay by 
simply clicking at the cancel 

button here.

Current Page Overlay

Visible Page Part Overlay

Navigation Overlay

Auto Scrolling is feature that smartens up the way you move 
around the page. Instead of scrolling based on constant values 
(pixels), ComicRack calculates automatically and dynamically 
the best scroll step for you, so that you could scroll in the most 
comfortable way. To enable auto scrolling, from the main 
menu, goto the read menu & click auto scrolling. While using 
the Reader, you can toggle auto scrolling on/off with the S key.  

Double-page auto scrolling is a complementary option that 
works only if Auto Scroll is enabled. This affects only double 
page spreads, by changing the page movement direction. 
This is noticeable if the page width is bigger than the view-
ing area and we don’t use Fit Width or similar modes. So you 
start from the top-left corner of the page displayed and then 
move to the top-right corner (instead of bottom-left with this 
option disabled). Most double-page spreads are supposed to 
be read this way, as our eyes follow from left to the right to 
the bottom.

Auto-Scrolling
Did you know?

The ComicRack Reader makes use of a number of overlays to display live information regarding the book cur-
rently being read. These overlays can be enabled/disabled via the options in the Reader setup tab of the Prefer-
ences dialog. Here we briefly discuss all the overlays.
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Page Layout

The Two Pages  (Adaptive) mode is the ‘classic’ ComicRack 
two page mode. Unlike the simple Two Pages mode that in-
troduces white fill pages alongside forced single pages, the 
Two Pages (Adaptive) mode doesn’t introduce any fill pages. 
The cover page is displayed as a single page, while rest of the 
pages as double pages.

The Fit Width (adaptive) mode splits a double-page and dis-
plays only half of it at once fitting it to width. This is espe-
cially useful for people with pivoted monitors or when book 
pages are scanned in a way where all the images consist of 
two pages on each one.

Adaptive Modes

The Page Layout (Number) options can be accessed from the 
Display menu (page layout sub-menu), Reader Toolbar, or 
Reader context menu (page layout sub-menu). You get the op-
tions for showing one or two pages at a time in the Reader win-
dow. You can also use the right to left mode for reading manga. 
If there are forced single pages (like a single page before a dou-
ble spread or before a page of type Cover), white fill pages are 
introduced.

The Page  Layout  (Fit) options can be accessed from the Dis-
play menu (page layout sub-menu), Reader Toolbar, or Read-
er context menu (page layout sub-menu). You get the options 
for fitting the pages by their width/height/all dimensions in 
the Reader window. The only fit if oversized mode can only be 
used simultaneously with the previously discussed page display 
modes. The only fit if oversized makes the original page size the 
limiting factor over the selected page display mode. Not select-
ing this option makes ComicRack “force fit” even smaller images 
by the chosen constraint.

Layout Options

The Rotation options can be accessed from the Display menu, Reader Toolbar, or Reader context menu (page 
layout sub-menu). You get the options for rotating the open book 90o, 180o, or 270o. You can also use the rotate 
left/right buttons to sequentially toggle between these available rotation modes. Please note that using the ro-
tation option, the entire open comic is rotated. If you wish to rotate individual pages, you should use the Page 
rotation options from the context menu of the Pages Browser. Also know that in either case, that the pages are 
rotated only for display in the reader, and pages in the comic archive are not altered (till you Export the comic 
to commit the changes). You can also choose the autorotate double pages option to let the reader window au-
tomatically display double-pages in  a 270o rotated state.

The ComicRack Reader gives you many options regarding how you want your pages to be displayed. You can fit 
them by height/width/both, or even read them right-to-left (for manga). This section summarizes all the options.
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Bookmarks are, in their simplest form, needed when you have to quit read-
ing a comic book and you wish to continue reading from the page you left 
it at. So you bookmark it and next time you can easily access it. Please 
note that for this purpose ComicRack already has the Open the book at 
the page where it was closed option. We recommend bookmarks for more 
intuitive scenarios like:
•	 As chapter jump points
•	 To mark backup features (or second-third-fourth-etc stories in Annuals 

or King-Size editions)
•	 If you combine multiple comics to one with export, the beginning of 

each comic book is marked with a bookmark.

The Pages browser showing the comic 
book pages grouped by bookmarks. 

See how comfortable it becomes 
to recognise them in this scenario. 
Double-click any bookmark header 

here to collapse/expand it.

The bookmarks menu in the reader 
window displays all the bookmarks for 
the open comic book. Every bookmark 

can be given an individual name, for 
example, as in this case, the chapter 

name.

Bookmarks

If you have a computer with a touch-
screen, you might find that gestures 
(motions that you make with one or two 
fingers) are easier to use than a mouse, 
pen, or keyboard. ComicRack recognizes 
a number of touch gestures on supported 
touch-enabled devices. Currently they 
simply map to square areas in the reader 
you can click. They are numbered left-to-
right, top down, from 1 to 9. By default, 
if you click (touch with touch display) in 
the upper corners you change page. In 
the lower corners, you auto scroll (with 
page change). 

By default, Gesture 1 is assigned to Previ-
ous Page action, Gesture 3 for Next page, 
Gesture 7 for Previous part and Gesture 9 
for Next part.

ComicRack also recognizes multi-touch 
gestures: you can zoom in/out, move 
around page, rotate page, and swipe to 
next/previous page.

TOUCH
gestures

ComicRack contains features for bookmarking your comic books at any (and any number of) page(s) that you 
wish. A page can be bookmarked using the Set Bookmark option, which can be found either in the Reader win-
dow (from the Bookmarks sub-menu in the Reader context menu), or in the Info dialog (Right-click on any page 
in the Pages tab).
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ComicRack 
comes with a number 
of features that enable 
you to personalize it to 
your liking. This chap-
ter will help you learn 
how to change the 
way ComicRack works 
to make it easier to 
use & more efficient.
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The Preferences dialog contains 5 
tabs, each of which has a number of 
sections / sub-tabs.
1.	 Reader Setup

�� Display
�� Keyboard
�� Overlays
�� Mouse & Scrolling
�� Hardware acceleration

2.	 Libraries
�� Book Folders
�� Scanning
�� Display
�� Sharing
�� Server Settings

3.	 Behavior
�� Starting ComicRack
�� Opening a Book
�� Reading
�� Right to Left
�� Browser
�� Application
�� Import & Export

4.	 Script
�� Script Packages
�� Available Scripts
�� Script Settings

5.	 Advanced
�� Languages
�� Books
�� Database Backup
�� Caches & Memory Usage
�� Hidden Messages
�� Explorer Integration
�� Wireless Setup

In the Preferences dialog, double 
clicking anywhere on the back-
ground toggles between the scroll 
and the tab layout. The scroll 
layout shows all the preferences 
options arranged in different sec-
tions in a single scrolling window. 
The tab layout has these very op-
tions arranged in their own sub-
tabs.

Preferences Dialog

If you have any of the following ‘How do I..’ questions, then look no further, the preferences di-

alog will help you:
•	 How do I add comic book folders to the ComicRack library ?

•	 How do I open new files in new tabs?

•	 How do I use custom keyboard shortcuts? 

•	 How do I increase the mouse wheel scroll speed?

•	 How do I make sure that deleted files don’t show up again in the library?

•	 How do I use ComicRack to check its RSS feed?

•	 How do I customize ComicRack for reading manga?

•	 How do I minimize ComicRack into the system tray?

•	 How do I change the ComicRack interface language?

•	 How do I remove the overlays?

•	 How do I backup my database?

•	 How do I open comic books from windows explorer directly with ComicRack?

The Preferences dialog is essential for configuring ComicRack according to your needs. It can be opened either 
via the Edit menu, or by using the Tools menu.
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Reader Setup Tab

In the Display section, 
turning High Quality 
option off increases page 
display speed on slower 
machines. 
Anamorphic Scaling 
stretches the comic book 
page to fit the screen in 
both dimensions. 

The Overlays section con-
tains settings for a number 
of enhancements for the 
reader window. Please read 
the section on Overlays to 
understand details regard-
ing their nomenclature.

ComicRack can be com-
pletely controlled by the 
keyboard. This section 
provides the default keys 
for various actions, all of 
which can be customised 
according to the user’s 
choice.

With Smooth Auto Scroll-
ing enabled, moving from 
one part of the page to 
the next is more fluent. 
This works only when auto 
scrolling is enabled from 
the Read menu.

You can also use the CTRL, 
SHIFT, or ALT keys to 
make a number of combi-
nations and permutations 
for making the shortcut 
of your choice. You can 
use the keystroke button 
(next to the CTRL/SHIFT/
ALT checkboxes) to directly 
input keys from the key-
board.

As we have already seen, during installation, ComicRack 
optimizes itself for your system. Most of the settings in 
the hardware acceleration section have already been se-
lected by ComicRack, and are the ones recommended for 
your system. If you do not desire the page display change 
animation, you may disable it. 

The Adjustments sliders 
provide easy changes to 
the saturation, bright-
ness, contrast, gamma and 
sharpening attributes of 
the comic pages.

All available overlays are 
shown in the overlay map 
here. You can uncheck the 
overlays that you do not 
wish to show in the reader 
window. The corresponding 
overlay in the map greys 
out. You can also choose 
to display the page name 
just below the current page 
overlay.

For each keyboard short-
cut, there are 4 options: 
1 Main and 3 Alternate. 
Each option has its own 
drop-down menu, from 
which you can choose the 
shortcut key that suits you. 

With inertial mouse scroll-
ing & hardware accel-
eration on, the scrolling 
of pages will continue, 
decelerating, even after the 
mouse button is released.

The Export button can be 
used to save the keyboard 
layout to an XML file on 
your PC. Such a keyboard 
layout can reflect your 
personal likings for the 
keyboard shortcuts, or can 
mirror the keys of some 
other comic reading soft-
ware that you had to use 
before ComicRack. 

Display

Overlays

Keyboard

Mouse & Scrolling Hardware Acceleration

The reader setup tab contains a number of self-explanatory options for customizing the  way you wish to read your comic 
books with ComicRack. There are 5 sections in the Reader setup tab: Display, Keyboard, Overlays, Mouse & Scrolling and 
Hardware acceleration. The important features are outlined below.
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Libraries Tab
The Libraries tab contains a number of self-explanatory options for customizing your ComicRack library. There are five 
sections in the Libraries tab: Book folders, Scanning, Display, Sharing, Server Settings. The important features are outlined 
below.

The Book Folders section 
helps in adding folders 
containing comic books to 
the library. These folders, if 
checked, would be watched 
for changes (move / 
rename) while the program 
is running. Using the open 
button, any added folder 
can be opened with win-
dows explorer.

The Scanning section has 
2 important options. The 
first option, if enabled, 
removes missing files from 
the library during the scan-
ning process. 

The ComicRack sidebar 
contains visual indicators 
that provide at-a-glance 
overview of the number of 
new, unread & total books 
present in each list.

The Sharing section is used 
for sharing libraries over 
the internet.

The Display section of the 
Libraries tab contains op-
tions to enable/disable the 
live counters.

You can also select to make your library editable or pass-
word protected (recommended). Please read the chapter 
on Network sharing for further details.

If  you try to edit metadata 
for files which you have not 
yet added to the library,  
the fields appear greyed 
out, not allowing you to 
select anything. First add 
your books to the library 
using the Book Folders sec-
tion & then you’ll be able 
to edit the metadata.

The second option comes in 
handy when you decide not 
to add a file to the library, 
while that file resides 
within a comic book folder 
that is already added to the 
library.

The Red gauge represents
new books added in the 
past 10 days. The yellow 
gauge indicates the unread 
book count, while the 
green one shows the total 
book count.

Select Add Share to open 
the library sharing config. 
Here you can also select 
if you want to share your 
complete library or only 
selected lists.

If you wish, you can also 
turn off the number count 
here, simply keeping the 
color indicators in the 
sidebar.

Book Folders

Scanning

Display

Sharing



ComicRack Manual | 6th Edition 43 Chapter 6: Configuring

Behavior Tab

The Starting ComicRack 
section contains startup 
tasks for ComicRack, like 
scanning for comic book 
folders and updating web 
comics.

Right-to-left mode is used 
while reading manga. 
Left/right movement is 
also reversed - if book is 
marked as Manga (right to 
left), or if your page layout 
is ‘Right to Left’ then page 
loads in upper right corner 
and goes to lower left.

Here you get the options 
for opening new comic 
books in separate tabs. 
You can opt to close the 
browser automatically 
whenever a comic book is 
opened. 

A couple of tweaks for the 
Browser. If you wish to dis-
play the browser docking 
grip while using the reader, 
you can check the option 
here. You can also opt for 
comic book tooltips while 
hovering your mouse over 
them in the browser. 

With the Blend animation 
while fast paging option 
unchecked, when you keep 
the page down shortcut 
pushed, it disables any 
page transition effect. If it 
is checked, animation ef-
fect is always turned on, no 
matter how fast you try to 
switch through pages.

The comic info dialog can 
display either simple or 3D 
covers, which can be tog-
gled by either clicking on 
them, or using the option 
here. You also have the op-
tion to hide the main menu 
(also see Tools menu, and 
use the Alt key).

We recommend that you 
mark all these options 
to run automatically at 
startup. You can also check 
for all the ComicRack news 
and keep informed about 
new releases.

True right to left reading - 
The whole book is mirrored 
and not only double pages 
reversed. So you’re really 
reading the book from back 
to front.

You can make ComicRack 
always open a new comic 
book in a new tab from the 
option here. You can also 
choose to open the comic 
book at the page where it 
was last closed.

Also present are options 
for thumbnail animations. 
The last option lets you 
display comic book ratings 
numerically. Unchecking 
this option will display the 
ratings as stars over the 
thumbnails

Keep the Fullscreen also 
toggles minimal user inter-
face option selected if you 
don’t want any menu or 
toolbar in fullscreen view. 
You can uncheck the reset 
zoom option if you wish to 
read all pages in a particu-
lar zoomed mode. 

If you wish to have the 
catalog field for all comic 
books, you can uncheck the 
option here that limits the 
catalog field to fileless com-
ics. Similar is the option 
for custom fields. Also, you 
can select to not show the 
quick open box.

Starting ComicRack

Right-to-Left

Opening a Book

Browser

Reading

Application

The Behavior tab contains a number of self-explanatory options for customizing the  way you wish to read your comic 
books with ComicRack. There are 7 sections in the Reader setup tab: Starting ComicRack, Opening a comic book, Reading, 
Right to left, Browser, Application, and Import & export. The important features are outlined below.
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Scripts Tab

Script Packages is the first 
section in the Scripts tab. 
It is used for installing/
uninstalling the scripts. It 
displays all the installed 
scripts, with a brief de-
scription of them.

Available Scripts is the sec-
ond section. In its default 
state, it contains a list of all 
the scripts that come bun-
dled with ComicRack. As 
new scripts are installed, 
they show up in the avail-
able scripts section.

The Configure button stays 
greyed out till you select a 
script that has options for 
configuration. Clicking it 
opens that script’s settings 
dialog.

You can click the Install 
button to browse to a 
script package, or simply 
right-click a crplugin file to 
open it in the Script pack-
ages section. Following 
this, clicking Ok restarts 
ComicRack & installs the 
script.

It can be used to disable a 
script without uninstall-
ing it. To disable any of 
these scripts, just un-check 
the checkmark next to 
the script name here, and 
restart ComicRack. Reverse 
the steps for reactivation.

The Script Settings section 
in the end contains an op-
tion for disabling all scripts 
with a single-click.

Script Packages Available Scripts Script Settings

Scripts are essentially plugins or add-ons that extend the functionality of ComicRack. They can be found in the Index 
of Scripts section of the ComicRack forum. They are usually distributed as a .crplugin file which can be simply double-
clicked to install. Working with scripts is explained in detail later in the Scripts chapter.

ComicVine Scraper
Automatically download metadata into 

your cbz comic book files

Duplicates Manager
Remove duplicate comic books with 

just a single click

Data Manager
Automatically enter metadata based 

on rules created by you

Backup Manager
Automatically backup your ComicRack 

database at startup or shutdown

Library Organizer
Organize & standardize the comic book 

file & folders on your PC

WeeklyComic Releases
Catch the latest RSS feeds for all the 

new comics released each week

http://comicrack.cyolito.com/forum/13-scripts/9505-index-of-scripts-updated-july-15-2012
http://comicrack.cyolito.com/forum/13-scripts/9505-index-of-scripts-updated-july-15-2012
http://comicrack.cyolito.com/user-forum
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Advanced Tab
The Advanced tab contains sections on the user language interface, database backup, cache settings, explorer integration 
and other options. Most of these are briefly discussed below.

The Languages section at 
the top helps select the 
user interface language of 
your locale. You just have 
to select your language and 
restart ComicRack for the 
language changes to take 
effect.

The cache is the maxi-
mum disk space you allow 
ComicRack to use to stock 
thumbnails, pages and 
comic books accessed 
through remote librar-
ies. It allows a smoother 
reading experience. Since it 
pre-loads images, you can 
browse quite fast through 
a comic book. You can also 
safely delete it.

The Books section has the 
option to allow ComicRack 
to write a small Comicinfo.
xml file to CBZ or CB7 
files. ComicRack organizes 
comic books by storing 
metadata as the ComicInfo.
xml file, which is also use-
ful in restoring your comic 
book database, in the event 
of a system format or file 
transfer. 

Optimized means that 
ComicRack keeps the com-
pressed image in memory. 
The advantage is that it 
can cache more image in 
memory, while the disad-
vantage is that it has to un-
compress them if needed 
(images stay uncompressed 
for about 5 seconds since 
the last use).

ComicRack provides for a 
quick and easy back up of 
your comic book database. 
It is a simple file copy of 
the ComicRack data-
base (ComicDB.xml) file, 
available for storage in a 
separate location from the 
original. 

Hidden messages are mes-
sage boxes you disabled 
(clicked never show again). 
To reshow these ‘hidden’ 
messages, simply click the 
reset button.

If your language is missing, 
you can translate Comic-
rack and submit your lan-
guage pack. Just click the 
help localizing ComicRack 
button to go to a webpage 
that details you on how to 
create language packs.

Default maximum cache 
size varies depending 
on the machine. It is set 
during installation of 
ComicRack (optimization 
part). The bigger the cache, 
the bigger the amount 
of images/thumbnails/
comic books that can be 
pre-loaded. The cache will 
increase in time as you use 
ComicRack. 

Please note that enabling 
these two options are 
essential to take full advan-
tage of the functionality 
of ComicRack. These are 
not enabled by default, as 
enabling them changes the 
hashes of the files. Ena-
bling them is an informed 
decision of the user.

Out of a number of 
supported formats, the 
checked ones will be as-
sociated with ComicRack, 
and opening any file having 
those extensions will auto-
matically launch them with 
ComicRack. If you choose 
to open PDF files with 
ComicRack, don’t forget to 
also install Ghostscript (see 
chapter 2).

The Database Backup 
section allows easy backup 
& restoration of all the 
comic book data to a small 
xml file on your computer, 
or on a USB drive. It is 
described in detail in the 
next chapter.

If the ComicRack on your 
Android/iOS device is not 
detected automatically by 
ComicRack for Windows, 
here you can add the IP 
address(es) for your wire-
less devices.

Languages

Caches & Memory Usage

Books

Explorer Integration Wireless Setup

Database Backup

Hidden Messages
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A vertical divider between double page spreads 
is seen, with a blank margin around the pages, 
signifying a real-like imaging of the open comic 

book. You can use the slider to change the 
margin size.

This will add a paper texture over 
the comic book itself, simulating 
such things as a blue-lined grid 

pattern , weathering or grains in 
the page.

Solid Color: This allows the user 
to choose one color to have 

as the one background for the 
reader area. If you would like 
to always have the comic sur-

rounded by black, for instance, 
you can choose that here. There 
are a total of 140 different color 

options. 

Texture: This will allow the user to load 
an image file to serve as the back-

ground. There are a number of these 
that come with ComicRack, and the 

user may also load their own. You have 
the option of either None, Tile, Center, 
Stretch or Zoom, as one would with a 

Desktop Background. 
You can also add your own textures 

to the C:\Program Files\ComicRack\
Resources\Textures\Backgrounds 

folder. You may also freely download 
background textures from the web.

•	 No Page Transition Effect: This 
will turn the page without any 
animations.

•	 New Page Fades In: This will 
turn the page with a fading 
transition.

•	 New Page Scrolls In Horizontal-
ly: The page will slide onto the 
reader in a sideways motion.

•	 New Page Scrolls In Vertically: 
The page will slide onto the 
reader from the bottom to the 
top.

•	 Page Turn Effect: This is an 
animated motion that simulates 
turning a page from a real comic 
by hand.

The background 
will blend with the 

primary color of the 
page displayed to 

create a solid color 
that will change as 
the page is turned 
and the primary 
color changes.

Realistic Book Display  (with margins)

Page Transition Effects

Paper Effects

Background Color

Background Textures

Adjust Color To Current Page

Book Display Settings

This option will allow the user to edit the background display of the ComicRack Reader Window, as 
well as choose between display options for the opened comic book itself. You can open this dialog by 
either using the Display menu at the top, using the Tools menu, or simply hitting F9.

http://comicrack.cyolito.com/forum/24-backgrounds-a-textures
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List Layouts

Edit Layouts

Save List Layout
List Options

Clicking the Edit List Layout button opens up the List Options window. 
It contains tabs for customizing the text shown below the thumbnails 
or tiles view, and the columns to be displayed in the details view. Se-
lect your required fields from the list options window, and click Ok. 

•	 All the columns that can be displayed in the Details view are 
shown in the List Options window. 

•	 The text under the comic book thumbnails in the browser can 
display a maximum of 3 lines. You have the choice of selecting 
the text that will be displayed there. 

•	 The text under the comic book tiles in the browser can be cus-
tomized using the metadata fields available in the List options. 
Please note that these options work only for individual tiles and 
not for stacked comic books.

Once you are satisfied with a list layout and 
wish to save it for quick use later, use the Save 
List Layout button. Give your layout a name, 
and click Ok. Your saved List layouts will now 
be accessible through the List Layout menu.

All your list layouts can be edited using the List Layouts dialog. From 
the Browse menu, go to the List Layout sub-menu, and click the 

Edit Layouts option. All the list layouts are now visible along with a 
description of the settings that you included in each of them. 

•	 Here you can make a new layout, and delete pre-existing 
layouts using the corresponding buttons. 

•	 You can also move a layout up or down the order. 
•	 The Activate button lets you change list layouts ‘on-the-fly’, so 

that you can easily visualise and choose from your favourite 
layouts. 

•	 The Set to all button sets the chosen layout to all the lists.

If you have a large number of lists, and you wish to assign them your favourite layout, you don’t have to repeat the same steps 
again and again. ComicRack provides for easy copying & pasting of list layouts, so that you may simply apply your preferred 
layouts to other lists with just the click of a button. You can access layout copy / paste options from either the layout menu or 
the details context menu. 
Here is how to copy / paste the list layout:
1.	 Once you are satisfied with a list layout, use the layout menu to copy the layout of this desired list. 
2.	 From the sidebar, select the other list to which you wish to paste the layout of the desired list. From the layout menu, 

select paste.
3.	 The layout of the selected list will immediately change to match that of your desired list.
4.	 Repeat Step 2 for any number of lists to which you wish to assign the layout chosen in Step 1.

Copy/paste List Layouts

Every list in ComicRack can have its own List Layout. A layout contains options for viewing, 
arranging, grouping and stacking comic books. Different situations require different List Lay-
outs. The comic book views have a number of options that are fully customizable and can be 
arranged in a number of ways. Sometimes you may want detailed view with columns, while 
for some lists, thumbnails view may work better. You may wish to increase or decrease the 
size of the thumbnails or tiles or rows (details view). You may group / arrange / stack them 
with the metadata fields of your choice. You’re free to choose whatever suits you. You can 
access the List Layout options either via the List Layout icon on the library toolbar or via the 
Browse menu.
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The multiple windows, panels and layouts of ComicRack are fully customizable and can be arranged in a number of 
ways. Such an arrangement is called a workspace. A workspace comprises settings for 4 features. These are Window 
layouts, List Layouts, Book Display Layout, and Book display Settings. While saving a workspace, you have the option of 
choosing any or all of these features to be included in your workspace. 

Workspaces

•	 Window state 
(maximized or not, 
fullscreen)

•	 Panels state, posi-
tion and arrange-
ment. For example :
»» browser docking 

mode
»» active browser 

tab
»» minimal user 

interface

Window 
Layouts

List Layouts Book Display Settings

Book
Display Layout

Different situations require different Workspaces. Manually rearrang-
ing and re-adjusting them every time is a hassle. Thus the option of 
saving multiple window layouts as workspaces within ComicRack. The 
Workspace options can be accessed from either the Browse menu or 
the Tools menu. Once you are satisfied with a particular layout and 
wish to save it as a Workspace for quick usage later, just click the 
Save Workspace button.

Saving Workspaces

Editing Workspaces

All your workspaces can be edited using the Workspaces dialog. From the 
Browse menu or the Tools menu, go to the Workspace sub-menu, and click 
the Edit Workspaces option. All the workspaces are now visible along with a 
description of the settings that you included in each of them. Here you can 
make a new workspace, and delete pre-existing workspaces using the cor-
responding buttons. You can also move a workspace up or down the order. 
The Activate button lets you change workspaces ‘on-the-fly’, so that you can 
easily visualise and choose from your favourite workspaces.
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If the Preferences dialog is the heart of ComicRack, the Info dialog is its 
brain. Essential for inputting and editing comic book metadata, the Info 
dialog packs 5 (by default) different tabs, each of which is described in 
detail in the coming pages. It also has 2 optional tabs that can be dis-
played by selecting the respective option in the Preferences dialog. 

To open the Info dialog: Right-click on any comic book in the browser 
and select Info, or from the Main menu, open the Edit menu & select 
Info.

There are 3 types of metadata fields in the Info dialog, all of which can 
be filled either manually or via scripts: 

The Info Dialog
Ty

pe
s o

f M
et

ad
at

a 
Fi
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ds

Text fields Text

Menus
Simple list

Yes/No fields

Option fields

Lists tab

Check tab

Text tab

have to be filled with relevant 
words or numbers. These include 
fields like Series, Title etc.

apart from the default choices, any user-
inputted word is also stored in the list and 
shows up in the drop-down

here you can only choose Yes or No from the 
drop-downdrop-down menus, where you 

select from an already-present 
list of choices. 

here you can select more 
than one option. Just like the 
text menus, apart from the 
default choices, any user-
inputted word is also stored in 
the list for re-use later.

Here you get checkboxes for each entry. Just 
select any number of entries you desire, and 
then click anywhere outside the tab to close 
it.

Double-clicking on an entry selects it and shows it in the box above. 
Double-clicking on any entry in the box removes it. You can also use the 
< < button to bring all entries in the box en masse. Single-click on any entry 
followed by the < button brings it in the box. Click anywhere outside the 
tab to close it.

The most simple one. Meant for users who like 
to use the keyboard more than the mouse. 
Just type in the names separated by commas, 
and then click anywhere outside the tab to 
close it.

Just click the  Add  item  button at the end of the field box to open the 
Add item dialog, which contains 3 tabs placed at the bottom: the Lists, Check 
& Text tabs.

The Lists tab of an Options field The Check tab of an Options field The Text tab of an Options field

Add Item 
button
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Summary tab

The text that you 
input in the Summary 

field of the Plot & 
Notes tab  will show 

here in the  Summary 
tab as the comic plot.

The comic book caption (Format/series/title/volume/number/year/month) 
and the creator info (Writer/Penciller/Inker/Colorist/Letterer/Cover artist)

Comic book specifica-
tions, including the 
size, pages and file 

format  (zip/rar etc).

The location of the 
comic book on your 

computer.

The comic book cover. 
You can click on it to 
get a 3D cover, and 

click back to revert to 
this simple one.

Comic book ratings that 
you can assign to any 
comic book by simply 
clicking &/or dragging 

on the stars here. 
Community ratings are 

blue-colored, while 
ratings assigned by the 
user (called My ratings) 

are yellow-colored.

The ratings assigned by you are called My ratings, while Community rat-
ings are average ratings from reviewers and readers around the world. 
Both these ratings can be viewed simultaneously in ComicRack. Based 
on your preference (from the Behavior button of the Preferences di-
alog), the ratings on the comic book thumbnails can be displayed either 
in a numerical manner (at the bottom right of the thumbnail), or as rat-
ing stars (at the top left of the thumbnail). The comics can be rated on a 
scale of 1 to 5, with 0.1 increments

Rating your comics!

From the right-click Browser context menu or the Reader Context menu, go to the My 
Rating sub-menu and click at the stars. If you want to give incremental rating, you can 
drag across the blank stars present at the bottom. The corresponding numerical rating 

will be displayed in real-time in the box on the right side.

The Summary tab is an all inclusive box that provides at-a-glance information for your comic books, one at a 
time. The upper panel of the Summary tab displays essential metadata, that includes the comic book caption and 
the creator info, along with a brief plot of the comic. This requires filling in the metadata fields (manually or via 
scripts) in the Details & Plot & notes tabs. The lower panel of the Summary tab displays the technical specifica-
tions for your comic book (like the file path, file format, size, number of pages, etc).
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Essential information regarding the series 
name, volume, number (n of total), year, 

month & day.
The title is the name of a particular issue of a 
series. You can usually find the title within the 

first few pages of a comic.

Essential information regard-
ing the comic book creators. 
Writer, penciller, Inker, color-
ist, letterer, cover artist, and 
editor. Helps in organising all 

comic books by, for example, a 
particular writer.

Essential information regarding the 
Publisher (and imprint, if any). You can 

then arrange or stack comic books in the 
browser by the “publisher” field.

Choose the Age Rat-
ing here from 

among All ages, ex-
plicit ,T+, A, Parental 

advisory.

Select Yes here to mark a 
comic book as Manga. Choose 
Manga (Right to left) to switch 
ComicRack to its manga read-
ing mode when this book is 

opened. Not selecting anything 
here marks a comic book as 

manga is unknown.

Select Yes here to mark a 
comic book to be belonging 

to a series that has now com-
pleted its run.

Select Yes here to 
mark a comic book as 

Black & White. Not selecting 
anything here marks a comic 

book as Black & white is 
unknown.

If required, you can choose 
the comic book Language 

here.

Here you can choose one or 
multiple genre for your comic 

book. Read in detail about it on 
the next page.

Use the Alternate Series field 
for crossovers (like Blackest 

Night) or story-arcs (like Sine-
stro Corps war) or for storylines 

(like Batman: reborn). The 
number field helps in making a 
chronology. A smart list based 
on these fields brings up the 

complete event in a go.

The comic book Format can be selected here. This 
includes Annual, Giant, One-Shot, Trade paper-
back, etc. You can also add your custom formats 

here.

Use the Tags field for any 
custom metadata that doesn’t 
have fields in the Info dialog, 
like scanners’ name, series 

status (ongoing, completed, 
mini-series), scan type (c2c, 

noads) etc.

The Previous and Next buttons are used 
to navigate between the Info dialogs 
of the previous and next comic books 

open in the browser respectively. So, in 
this case, you don’t have to close and 

open the info dialogs repeatedly.

The Proposed Values button is used for metadata auto-
discovery that ComicRack does by processing filename. 
It’s there for convenience, so those fields wouldn’t be 
empty by default. You can commit them permanently 
(for example with the Commit proposed values script) 

or hide them, if the guess is wrong.

The Details tab is the key to inputting the comic book metadata that forms the basis of organizing your comic 
book collection. Just like tags in a music file, comic books can contain a variety of metadata. While ComicRack 
supports scripts to automate this process from online databases, you always have the option to fill in every detail 
manually. All you need to know about the Details tab is given below.

Details tab

You just have to switch the Proposed Values from Yes to No. Then validate the change by 

clicking on Ok which will close the info window. When you open the info window again, the 

series field will be blank and you will be able to specify whatever you want. 

Is there any way to leave the ‘Series’ field blank? 

I’ve tried deleting it manually, but it appears again after the field loses the focus.FAQ
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Input the teams 
(like Justice league, 
Avengers, etc) here. 

Input the locations 
(like Gotham city, 
Metropolis, OA, 

Asgard etc) here.

The Scan Information field is 
used to keep any info about 

the comic scan, like the name 
of the scanner, resolution of 
the scan, or the type (c2c, 

noads etc). We have scripts 
that automatically fill in these 

data for you. More on that 
later. The web address of the comic book goes here. This shows 

up in the summary tab as well as when you click the arrow 
mark next to the comic book name in the details view of 

the browser.

•	 The Summary field should 
be filled with a brief text 
that highlights the plot of 
the comic book. 

•	 You may use Notes for 
whatever purpose you wish. 

•	 You can write your reviews 
in the Reviews field. 

Input the name of the main 
character or team (like Wolver-
ine, Batman, Hellboy, Avengers, 
etc) here. This will later help in 
grouping/stacking by the Main 
character or Team field, or in 
making smart lists. Make sure 

you don’t input multiple names 
here.

Plot & Notes tab

Input the characters featured 
in the comic (like Hal Jordan, 

Abe Sapien etc) here. 

The Plot & notes tab complements the Details tab.  While the details tab contains metadata fields which are 
essential for organizing your comic books, the Plot & notes tab helps complete the metadata, specially to satisfy 
advanced comic book enthusiasts! Metadata fields like Characters, Teams and Locations bring on a large number 
of possibilities regarding the comic book grouping in the browser. An overview of the Plot & Notes tab is shown 
below.

You can search Wikipedia from within ComicRack!
•	 Right-click inside any metadata field to bring up the context menu with the 

wikipedia search results at the top
•	 Click the arrow mark next to the comic book name in the details view of the 

browser. You will get both the wikipedia search results as well as the comic 
book web address that you input in the Web field (Plot & notes tab)

Search Wikipedia!
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The Pages tab con-
text menu provides 
options for viewing, 

arranging, and 
grouping the pages.

Drag & drop individual pages to 
change the page order. Double-

click a page to open it in the 
Colors tab.

Opens up sub-menus for 
Changing the Page type 
and the Page rotation.

Right-clicking on any page in the 
Pages Tab invokes the Pages Context 

Menu. This contains options for 
changing Page Type, Page Rotation, 
Adding / removing Bookmarks, re-

ordering pages within a comic book, 
copying page(s) to another location, 
selecting & refreshing, and deleting 

pages from ComicRack.

The Previous and Next buttons 
are used to navigate between 
the Pages tab of the previous 
and next comic books open in 

the browser respectively. 

The Reset button 
brings back the de-
fault values for the 

page attributes.

Pages tab
The Pages tab in the Info dialog shares a lot of similarities with the Pages Browser (see Chapter 04). Just like the 
pages browser, the pages tab also has the Pages context menu and the Page browser context menu (called the 
Pages tab context menu here).

You have to make sure that the Pages are arranged by Page (& not by type, size, width etc). 

For doing this, click at the Pages Tab Context Menu at the upper right corner, and from the 

Arrange by sub-menu, choose Page. You can now drag-and-drop pages successfully.

Why do I get a red cross when I drag-and-drop page 

thumbnails in the Pages tab?FAQ
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Find a white spot (usually 
text bubble background) 

and double-click on it 
and it’ll manually adjust 
the other colors relative 
to the color at the spot 
you clicked such that it 

is balanced. This is really 
most applicable to poor 

scans of discolored books 
to adjust yellowing. 

Good scans of new books 
should require very little 
white-point adjustment. 

Click the Image Control button to slide open a panel containing 
the color attribute settings.

Click the Reset button 
to bring back the default 
values for the color at-

tributes.

Saturation decreased to -100%

Brightness decreased to -25%

Contrast increased to +50%

Gamma increased to +50%

The First, Previous, 
Next,and Last buttons 
are used to navigate 
between the Color 

dialogs of the respec-
tive pages of the book 

whose Info dialog is 
currently open.

The Image Con-
trol  panel contains 
sliders for changing 

the attributes for 
brightness, contrast, 
saturation, gamma, 
and sharpness. Drag 
the sliders right/left 
to get the desired 

effects.

The Colors tab is used for adjustment of the intensities of the color  attributes 
of the comic book pages, viz. Saturation, brightness, contrast, sharpening and 
gamma.
•	 Saturation: The ‘purity’ of a hue; or, more precisely, the intensity of one color channel 

relative to the intensity of the other color channels
•	 Brightness: The relative lightness or darkness of an image, or of a particular color in an 

image 
•	 Contrast: The relative difference between lightness and darkness in an area of an image 
•	 Sharpening: An image effect that is used to adjust the image contrast by enhancing the 

definition of the image edges
•	 Gamma: Gamma affects how a computer generates images. An effective gamma rating 

will deliver true colors and a good range of light, middle, and dark tones.

Sharpness increased to +4

Colors tab
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The blank Info dialog resembles the comic 
book Info dialog a lot, but has minor 

differences. The Pages tab, for obvious 
reasons, is not seen.

From the File menu, select 
New Fileless Book Entry. A blank 

Info dialog box will open.

Enter the relevant metadata for your 
comic entry just like you would do for a 

comic book.

Add thumbnail and/or ratings to your 
comic entry. You can use the link to file 
button to browse and link a file of any 

supported format (like CBR, CBZ etc) on 
your system, thus converting the fileless 

entry into an actual comic book.

Fileless comics

Why fileless?
There are many scenarios in which you may 

find this feature quite useful. For example, if 

you wish to delete a comic book (or comic 

book series) from your hard drive, but keep 

the info in the database (for saving hard disc 

space, or removing a comic book that you 

didn’t like).  Also, if you do not have some 

comic books in your digital collection, yet 

want the respective info in ComicRack, you 

can make dummy entries for such comics.

ComicRack also supports Fileless comic entries into the database. This way 
ComicRack becomes a full blown ‘paper’ comic database management tool. 
Double-click a fileless entry to open up its Info dialog. Managing fileless 
comic entries/series is more-or-less similar to their real counterparts, the 
comic books. Once you add the relevant metadata, the file-less entries/se-
ries are added to the ComicRack library database.  Essential ComicRack fea-
tures like lists, copying/pasting data, search, browser views/navigation are 
the same for the file-less entries.

1

2 3 4

Adding file-less entries for a large number of comic books can be time-con-
suming. ComicRack supports adding all required issues of a series in a go. 
1.	 From the File menu, select New Fileless Book Series. The New Fileless 

Book Series dialog box will open. Add the name of the series, number 
(range), and volume (if any)

2.	 Click OK to get the entire series (with the issue numbers you specified) 
in the browser. You can now edit them either en masse, or individually 
like separate file-less comic entries.

Fileless Book Series

The Views button on the browser toolbar has the Show only fileless entries option. Clicking 

this option filters the current list and shows only the fileless entries present in that list. Using 

this option on the entire library shows all your fileless comics.

How do I quickly find all my fileless comic entries?
FAQ
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Optional tabs

Yes, the catalog tab can be used with all your comic books, and is not just limited to fileless 

comic entries. However, by default, it is active only for fileless entries. Open the Preferences 

dialog and go to the Behavior tab. From the Application section/sub-tab, uncheck the Show 

catalog fields only for fileless comics field.

Can I get the Catalog tab for all comic books ?
FAQ

The Catalog tab is a very useful field when it 
comes to managing your ‘paper’ comics. It con-
tains important information about the comic con-
dition, price, store, owner, ISBN number, collec-
tion status and more. You can input the number of 
pages in a fileless comic, as well as the date when 
you purchased it. The Age field classifies the comic 
book into its respective age or historical era.

One noteworthy field here is the Released field, 
which is used for the In store date (zero day date, 
when the book is available in the shops). This is 
different from the date fields (year/moth/day) you 
see in the Details tab, which is the Cover date (this 
is the date printed inside the cover).

The Custom tab allows you to have metadata fields 
of your own choice. Just input a name in the blank 
tab under the Name column, hit Ok, and you’ll 
find this as a new metadata field throughout all of 
ComicRack.

There are many ex-
amples where custom 
fields fulfil important 
organisational needs. 
For example, grouping 
comics belonging to 
the ‘Star Wars’ family. 
Here users create cus-
tom fields like Era and 
Timeline Year to organize their Star Wars comics.

Catalog Tab Custom Tab

The Info dialog for the fileless comics contains an additional tab labelled Catalog. This is optionally also available 
for normal comics too (see below). Another optional tab is the Custom tab, which can be turned on by checking 
the relevant option from the Preferences dialog (Behavior tab -> Application section).
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So far, we have discussed filling the 
metadata for individual comic books. 
ComicRack also supports batch pro-
cessing of multiple comic books for 
inputting and editing metadata. This is 
accomplished through the Multiple book 
Information dialog. To open it, select 
multiple comic books and open the Info 
dialog as you would do for a single comic 
book. The Multiple book Information di-
alog contains metadata fields of both 
the Details tab and the Plot & notes tab 
of the Info dialog arranged in separate 
sections/tabs. The Catalog field is also 
present in the The Multiple book Infor-
mation dialog for comic books as well as 
for fileless comic entries.

Checkboxes
The Multiple book Information dialog 

contains 3 types of checkboxes, which are in-
terpreted differently with regard to the type 
of the metadata field:
For text fields or menus (yes/no, sim-
ple list):
•	Value is identical in all books: 

Checked
•	Value is different for at least one 

book: Unchecked

For option fields:
•	 Value is identical in all books: 

Checked
•	 Value is different for at least one 

book: Indeterminate
•	 No value will be set: Unchecked

Multiple
book info

Copy & paste data

The Paste Data feature helps you to manu-
ally transfer the metadata from one comic 
book to another, without needing to import 
the data anew. Examples include replacing 
comics with those of better quality, or those 
with additional pages. 

The Paste Data feature is also useful when you have a number of 
comic books that are supposed to have similar metadata (like differ-
ent issues of a series having a common creative team, the same pub-
lisher & the same genre), but you have the metadata filled in only for 
one, or a few, of those comic books. In this case, you can simply use 
the Copy Data option from the comic book with the maximally com-
plete metadata present, and select the rest of the comic books and 
select Paste Data. More often than not, ComicRack itself will ‘intel-
ligently guess’ your desire & keep only the relevant metadata fields 
checked. You can make yourself doubly sure by unchecking metadata 
items you do not wish to paste.

To add the data to the new comic, right-click on the original comic 
book in the browser window and select Copy Data

Then right-click the new comic and select Paste Data

This will open the Paste Data dialog box. There are three options; All, which will add a check to every 
data item, Only Set, which only select those items that actually have data, and Clear, which will un-

check all data and allow you to only select those items you wish. It contains sections/tabs titled Main, 
Artists/People involved, Plot & Notes, and Catalog.
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Choose the file format

Choose the page for-
mat. ComicRack also 
supports the WebP 

image format (which is 
30 % smaller than jpg).

Choose compression

Choose resizing op-
tions.

Choose the ex-
port location.

You can select multiple comic books and 
choose to combine them during export.
You may also choose whether you wish 

to keep the original comic books, or 
delete them after export.

If you wish, you can modify the color 
attributes of the comic book pages to 
your liking. Available are options to 

change the saturation, brightness, con-
trast, gamma and sharpening attributes 

of the images.

The exported comic book can be named 
according to its preexisting filename, or the 

comic caption (which is the standard for-
mat used by ComicRack for naming comic 

books) or your custom choice.

You can select from this 
drop-down menu which 
page types you wish not 

to include in the exported 
comic book. Please read the 
chapter on Browser to know 

more about page types.
You can choose 
to split double 

pages to 2 single 
pages each dur-
ing the export.

Similar to other ComicRack dialogs, double clicking 
anywhere on the Export comic books dialog back-
ground toggles between the scroll and the tab lay-
out. The scroll layout shows all the export options 
arranged in different sections in a single scrolling 
window. The tab layout has these very options ar-
ranged in their own sub-tabs.

Exporting Comics

You can also create your own presets for easy repetition of specific export set-
tings. To create a preset, first open the Export comic books settings menu and 
then set any settings you want your preset to have. After you get the settings to 
your liking, click the Save button and give your preset a name. The preset will 
now show up in the right-click→Export comic books menu. Included are presets 
for CBZ and CB7.

Creating export presets

ComicRack has many options to export comic books. To convert a comic book 
to another format, right-click on it in the browser, go to Export comic books 
and simply choose your format. A batch of comic books, or even your com-
plete library can be converted in a similar fashion.
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Database Backup

Once you have completed entering all the metadata, bookmarking your comic books, adjusting the colors, rat-
ing them, making lists, you wouldn’t want all the effort go in vain just because of an accidental deletion, a virus 
attack, or a software or hardware failure. ComicRack provides for a quick and easy back up of your comic book 
database. It is a simple file copy of the ComicRack database (ComicDB.xml) file, available for storage in a separate 
location from the original. 

If you would wish to backup absolutely everything, you would have to do so manually. Open an 

explorer window and just go to: %APPDATA%\cYo\ComicRack\ 

Copy the Config.xml file to a safe location. While restoring the database, paste this file back in this 

location. On restarting ComicRack, all your preferences & presets will be preserved. 

Just be sure to put all your comics files back into the same main folder they were in before when you 

restore. So if they were in C:\Comics then that’s where you need to copy them after you reformat.

How do I backup my list layouts & workspaces? 

I’m formatting my PC, and would like to back up all my settings. FAQ

Follow these simple steps to backup (and then later restore) 
your database:

1.	 From the Advanced button of the Preferences dialog, just click the backup database 
option.

2.	 An explorer window will open, where you can browse to the location of your choice 
and then click the save button. The database will be saved with the name ComicDB 
Backup along with the date of saving the database.

3.	 To restore your backed up database, from the Advanced button of the Preferences 
dialog, click the restore database option.

4.	 An explorer window will open, where you can browse to the location of your saved 
database. Select the desired database and then click the open button, or simply 
double-click the saved database.

5.	 On closing the Preferences dialog, ComicRack will prompt you for a restart. Click the 
restart button to complete the database restoration.

Absolutely all the metadata is backed up by the Backup database feature, including:
•	 Comic-related metadata: all fields in the Details tab & Plot & notes tab of the Info dialog
•	 Non-comic metadata: literally everything, including properties of every single page of the book, 

page type, rotation, bookmarks, last page read, date added/opened, rating, color adjustment, 
file modified time, file creation time etc.

•	 Lists (both custom lists & smart lists), together with their individual layouts

The following features are not backed up by the Backup database feature:
•	 Workspaces
•	 List Layout presets
•	 Options from preferences dialog
•	 Export presets

What is backed up?
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A Reading List is a compilation made up of a list of books from your ComicRack 
library. You can use lists to organize a group of comic books matching a particular 
criteria. All the lists are accessed from the sidebar, which, thus, is essential for 
working with lists. 

There are 2 types of lists:
1.	 Custom List: This is a simple list of comic books, made by manually adding individual comic books to it. This 

is a compilation of comic books for quick access, analogous to playlists in a music player.
2.	 Smart List: This is an ‘automatized’ list, in which you create a rule (or many rules), and ComicRack automati-

cally adds all comic books fulfilling the rule(s) to the smart list. As new comic books are added to your library, 
ComicRack auto-updates your smart lists.

Custom Lists Smart Lists

Introduction to Lists

Use these buttons to open a list in 
its own tab or window (you can also 

right-click on the list name, and choose 
Open in new window or Open in new tab).

You can also drag a comic book(s) from a 
list / smart list in one tab and drop to a list 

(not smart list) in another tab. 

Smart lists consist of rules the user can 
define in order to create dynamic, self-

updating lists of comics. ComicRack itself 
comes with seven built-in smart lists:  ‘My 

Favorites’, ‘Recently Added’, ‘Recently 
Read’, ‘Never Read ‘, ‘Reading’, ‘Read’ and 

‘Files to update’.

If you have lists that you use very fre-
quently, you can click here to have them 
displayed in the Favorites panel (you can 
also right-click on any list and select add 

to favorites). Your list will now show in the 
Favorites panel and can be accessed more 

quickly.

The Sidebar with all the custom lists & smart lists

Here you can create a new folder to 
organize your lists.  You can also cre-
ate folders within folders. Lists (and 

folders) can be dragged and dropped 
from one folder to the other. 

•	 To create a list directly inside a 
folder, first click on the desired 
folder, and then create the list. 

•	 To create subfolders (folders 
inside other folders), first click 
on the desired would-be par-
ent folder, and then click the 
New Folder icon.

Converting a subfolder into a folder

By default, all the books that you have added 
to ComicRack are located in the (virtual) 

Library folder.

Lists: Basic Concepts
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Your New List shows in the Sidebar. It can be dragged up 
or down the lists, or in or out any folders.

Please note that the newly added custom list is empty, 
till you manually add comics to it.

Creating New Lists

All the reading lists (custom lists as well as smart lists) live in the sidebar. You create new lists from chosing the 
relevant options from either the Sidebar Toolbar, or the Sidebar context menu.

To create a new custom list, either click the new list icon on the sidebar 
toolbar, or choose New List from the Sidebar context menu (appears 
on right-clicking anywhere inside the sidebar). The New List dialog box 
opens up. Here you can give your new list a name.

Adding comic books to the list can be done in 2 ways:
•	 Drag the comic books from the Browser and drop them on top of your list. You can drag & drop them either one by one, or selecting 

multiple comic books in the browser (using the Ctrl key). 
•	 Alternatively, you can right-click any (or a group of) comic book(s) in the browser to open the browser context menu, and goto 

Add to List. Select from names of all the reading lists in your library.

Creating a new custom list

Creating a new smart list

Negate rule

Name

Limit by number 
or size

Select this option to 
show the smart list in 
the Quick Open box

Click this button to 
slide open additional 
options for setting up 

your smart list. 
If you do not wish to 
configure these ad-

ditional options now, 
you may leave these 
empty to be filled up 

at any later time.

Match All/Any rule in 
Library/List

Add a brief descrip-
tion of the list. This will 
appear as a tooltip on 
hovering the mouse 

over the list name in the 
sidebar.

To create a new smart list, either click the new list icon on the sidebar 
toolbar, or choose New Smart List from the Sidebar context menu.
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Metadata field Instruction Keyword Match Value

Once you have created a new smart list, just pick a metadata field from the leftmost drop-down menu, choose an 
instruction from the second, and fill in a complete or partial keyword in the third (text) field.

Most of the times, users feel the need to use more than one rule to specify the content 
they desire in their smart lists. For working with such multiple rules, click the button 
at the far end of the text (keyword) field to open up a drop-down menu. This contains 
options for making as many rules in a smart list as required.

Clicking this 
button opens 

up a drop-down 
menu having op-
tions for working 

with multiple 
rules/groups. 

The keyword 
can be, for 

example, the 
name of a 

series, charac-
ter, file path, 

publisher, etc. 

Double-click the text/keyword 
field to open up the Match 

Value dialog box, which is used 
as an expression editor.

You can also make rule groups. A rule group (or simply, a group) is a 
compilation of a number of rules. A group can be further enhanced 
by the any/all option, or the negation function. Just like the rules, 
there is no limit to the number of groups you can make in a smart 
list. You can also have groups within groups (for advanced users). 
The rules/groups can be moved up/down, or cut/copied/pasted 
within the smart list, and of course deleted.

Smart Lists
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Smart List Basics

In its default state, every smart list contains one rule that will search for anywhere in 
“All” the comics’ data that “contains” nothing. You can change the blank keyword field 
to anything you like. For example, if you simply write ‘Batman’ in the keyword field and 

click Ok, the smart list would now display all books with Batman in their data.

The ! (negation) button finds the opposite of what you specify. To continue the Batman 
example, if you set the “!” button, the smart list would display any comics that do not 

contain Batman.

If you only want to search for a phrase in a certain field, you can change the metadata 
field “All” to something else. For example if you wanted to find all the Batman titles you 

could set the search to be: “Series” “contains” “Batman”

You can also change the instruction field (second drop-down menu). 
For example, if you want to find an exact word or phrase you could change the option 

from “contains” to “is”. 

If you specify Match All, then all the rules would have to be true for a comic in order for 
it to be displayed. If you specify Match Any, then if any one rule is true for a comic it will 
be displayed. Click the  button next to a rule to open the drop-down menu, where you 

get the option to add / delete new rules to / from the smart list. 

A number of metadata fields do not contain the keyword field. These are the fields that 
have a yes/no response. e.g. Manga, Series Complete, Black & White, etc.

Advanced users can also make highly intuitive smart lists by employing the expression 
editor from the Match Value box.

To create complicated and very specific rules, you can create rule groups. Click the  
button and add a rule group. With each group you can specify to follow all or any of the 

rules in the group.
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In this example, we first filter our library using the search browser. We select ‘Sarah Ellerton’ from the writers field in the search browser, which filters the total 22 comics 
in the list to 5 written by Ellerton. Now, click the duplicate current list button on the browser toolbar. Choose the location from drop down list of the folders the dupli-
cated list could be stored in. A new smart list titled ‘Sarah Ellerton’ appears in the temporary lists folder. Click edit to see what its rules are. You will find that smart list 

has filtered the list according to the criteria we chose.

To remove a comic book (or a batch of comic books) from a list, select the comic book(s), right-click, and choose Remove. This will only remove a reference to the 
comic book from the list, not delete the actual comic book. You have the option to choose to also remove the book from your library, and even from your system 

Please note that in case of smart lists, the Edit Smart list dialog has the Reset button to bring back deleted comics. You would need to slide open the additional options 
section for this.

The duplicate current list option is something different than simply copying/pasting a list. It builds a new smart list 
out of your current settings. If you did not make any changes, it does not create a new list. It takes into account the 
filters in Search Browser, Quick Search and options in Views (read / not read / reading / duplicates).
Click a list (either custom list or smart list), type something in the quick search or choose a filter in the search 
browser. Once the filtered comic books show up, click the duplicate current list button and you will get a new list 
(with the same name) in the folder of your choice, following the rules of the original list PLUS whatever extra filters 
you applied. This is the quickest way of creating smart lists.

Working With Lists

Reading Lists can be easily edited. Both custom lists and smart lists can be renamed, deleted, moved from one 
folder to the other, and opened in their own tab or window. To edit a custom list, you have to manually add or 
remove the comic books in the the list. On the other hand, editing in smart lists is largely done by modifying the 
rules that constitute the list.

Duplicate Current List
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Export/Import Lists

Both custom lists and smart lists can be exported from or imported into ComicRack. There are a number of rea-
sons why you’d want to export a list: first, you could export the list to import it into another ComicRack installa-
tion. Second, you can export a list to put it online, or email it to a friend, for example. Exporting lists only backs 
up the information related to the list; exporting lists doesn’t backup your comic books. Similarly, Importing lists 
only adds the information related to the comic books added in the list; importing lists doesn’t copy actual comic 
books. Importing a list is a quick and easy way to exactly reproduce a particular compilation of comic books with-
out having to manually add the comic books, or adding them in a particular order.

While the process of importing either custom lists or smart lists is the 
same, there are a few differences. On importing Smart lists, Comic-
Rack simply match the defined criteria to the comic books present 
in your ComicRack library, and present a compilation of comic books 
matching that criteria. On the other hand, when custom lists are im-
ported, ComicRack will match the comic books in the list with those 
in your library. If some comic books are not present/matched, you 
will get the option to still add them to your library as fileless comic 
entries.

Right-click on any list (custom list or smart list) in 
the sidebar and select the export reading list or the 

import reading list option.

This will open an explorer window, where you can browse a location of your choice and click Save 
to export your list, or select the list you want to import and click Open.

Double-clicking any reading list from windows explorer opens it directly in the Temporary 

Lists folder. Any list kept here is deleted on the next run of ComicRack. So, if you wish to 

preserve a list, always remember to move it out of the Temporary lists folder.

What is the Temporary lists folder?FAQ

1 2
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Text-based Editing

ComicRack smart lists also support a text-based query language. To invoke the text based smart list editor, press 
Ctrl while clicking Edit. Text-based smart list editor also supports copy-paste functions. Just select the text in a 
list, copy it to the clipboard, right-click any folder in the sidebar and click Paste list.

Right-click any smart list to bring on the Sidebar context menu. While press-
ing Ctrl on your keyboard, click Edit. 

You can right-click inside the Text based smart list editor to get the 
context menu, which has quick links to insert the match & value 

expressions.

This is the text-based smart list editor, where you can write the smart list rules, 
as you would do in a language like SQL.

You can also enter smart list query expressions in the Quick search text field, to filter the books 
in the library with the chosen expression. Here in this example, we search for books which have a 

rating of more than 3.

You seem to have toggled the sidebar off. All the reading lists load in the sidebar. if you have 

selected a list first & then toggled off the sidebar, you won’t be able to access your complete 

library till you bring back the sidebar & select the library folder. So, it is highly recommended 

to keep your sidebar ‘on’.

Help! I can’t see my lists anywhere. 
I swear they were here yesterday, and now they are nowhere to be seen!FAQ
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A ComicRack script is distributed as a .crplugin file. These are zip files with the .zip extension changed to the .cr-
plugin extension. Installing a script is very easy. Please note that, after installation, most scripts require a restart 
of ComicRack, and will prompt you for the same.

What are Scripts?

Scripts are essentially plugins or add-ons that extend the functionality of ComicRack. With scripts, you can batch 
process books in ComicRack. A number of tedious manual tasks can be accomplished with just the click of a but-
ton. This gives you more time to actually read your comic books than manage them! A large variety of scripts 
are currently available. The scripts are usually distributed as packaged zip files. These scripts can be freely down-
loaded from the Index of Scripts from the Scripts section of the ComicRack forum.

You probably have an old Comicrack script, which earlier used to be distributed as a simple 

zip file. Open the Preferences dialog, and click the Scripts button. Click the Install button. 

Browse to the downloaded zip file and select it. Restart ComicRack and the script(s) will be 

installed and available to use.

How do I install a script which is just a zip file?

I just downloaded a script from the forum, but it is in the form of a simple zip file, & not a crplugin.FAQ

The script manager displays the script under the heading to be 
installed (requires restart). Click Ok to restart and complete 
installation.

Simply double-click a crplugin file to start the installation 
process. You can also select the file and then click Install 
plugin into ComicRack from windows explorer.

Just as you install a 
script, uninstalling 

it is an easy and fast 
procedure. To uninstall 
(remove) a script: Open 
the Preferences dialog, 
Go to the Scripts Tab, 
select the script you 
wish to remove, click 

Remove followed by Ok 
& restart ComicRack

After installation, most modern scripts can be accessed via their icon on the Browser Toolbar. Some scripts also 
have a drop-down configure menu in the toolbar icon itself. Some scripts are configured via the Automation 
Menu, under File menu -> Automation. Any script can be disabled (without uninstalling) from the Script settings 
section of the Preferences dialog. 

http://comicrack.cyolito.com/forum/13-scripts/9505-index-of-scripts-updated-july-15-2012
http://comicrack.cyolito.com/forum/13-scripts
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ComicRack comes pre-loaded with a number of scripts. This 
section briefly discusses these built-in scripts, while the forth-
coming pages discuss scripts downloadable from the Comic-
Rack forum.

Most of the built-in scripts (and also those that you install lat-
er) can be accessed from their respective icons on the browser 
toolbar. Some of the scripts require going to Browser context 
menu → Automation.

Built-in Scripts

Make the proposed values for the 
comic books permanent

Search and replace values in selected 
comic books

Export the list of selected comic books 
(or the entire library) into a csv file

This is a script to renumber the selected comic books. To use the script, either click 
its icon on the browser toolbar, or right-click the selected comic book(s), and via the 
Browser context menu go to Automation → Autonumber wizard.

•	 Number Series: changes the number field of the series accordingly
•	 Number Alternate Series: helpful in making chronologies (see example below)
•	 Begin at number: the starting issue number of the series being renumbered
•	 Save total number: this will be the total count of the series

Arrange the comic books in the chronological 
order you want them in. Sort descending by the 
position field.

The series now has all the alternate number 
fields in order. You can now arrange them by 
the alternate number field.

While keeping all the comic books selected, open 
the Autonumber wizard. Choose number alternate 
series from the drop-down menu. Begin at number 1 
& also input the total count.
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SCRAPERS
These scripts import comic book infor-
mation from an internet database. Such 
scripts are used when you wish to add 
metadata from the web to the comic 
book archives in your ComicRack library. 

SMARTLIST SCRIPTS

Smart list Scripts are a special category 
of scripts that can be used only with 
smart lists. These scripts utilize the User 
Scripts metadata field. 

MANAGERS
These scripts move, rename or delete 
files based on the comic book metadata. 
Using these scripts, you can organize, 
un-dupe, and convert your comic books. 

INFOPANEL SCRIPTS

These scripts use the Info Panel for 
elegant & meaningful display of a lot of 
comic book related information, based 
on the metadata available.

ORGANIZERS
These scripts modify comic book infor-
mation. Using these scripts, you can get 
scan Information from filename, erase 
first page advertisements, copy or move 
information from one metadata field to 
other, and much more.

ENHANCERS
These scripts enhance the native func-
tionality of ComicRack. You can get RSS 
feeds for new comics, open comic books 
from within ComicRack with your favorite 
programs (like WinZip), extract pages 
and much more.

Recommended Scripts

We now discuss the downloadable scripts divided into functional categories for your convenience. With such a 
wide variety of scripts out there, a new user can easily get overwhelmed as to which ones to use. While this is a 
matter of personal preference, the ComicRack team now makes the task easy for you by providing its own recom-
mendations for must-use scripts. Some noteworthy scripts are also mentioned.
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Scrapers
These scripts import comic book information from an internet database. Such scripts are used when you wish to 
add metadata information from the web to your comic book archives in the ComicRack library. 

Add new fileless comic entries via 
scanned barcodes

Scrape data for comic books from the 
Bedetheque website.

Scrape data for comic books from the 
Inducks website

The importance of metadata in organizing and 
managing comic books has been already empha-
sized at many places earlier in the manual. Manu-
ally filling the metadata  fields for comic books 
and fileless entries can be a very slow and inef-

ficient process. Neither would it be easily possible 
to be accurate and complete.

The Comic Vine scraper automatically scrapes (reads, retrieves, and 
saves) comic book information from the Comic Vine online data-
base, and automatically fills all the metadata fields in the Info dialog.

The Comic Vine Scraper also has its own project page. Here you can 
find more information regarding the advanced use of this script, as 
well as download the latest version of the scraper. 

To open the scraper, select a book (or a batch 
of books) and either click the green icon on the 

library browser toolbar, or Right-click → Automa-
tion → Comic Vine Scraper. Click Start Scraping to 

begin the automated process.

Rescraping is needed either when you wish to 
update the information on an already scraped 

book, or when you accidentally scraped incorrectly. 
Rescraping comic books becomes faster if the 

previous choice is saved. The Rescraping options 
in the Behaviour tab of the settings dialog let you 
choose if and where the choice should be saved. 

If you want to review every single comic before scraping it, you should turn on 
the confirm each issue before proceeding option. The scraper finds a number of 
matches for the series being scraped. Most of the times, the desired series would 

be found at the top of the list. Choose the correct series, and then click Ok to 
move to the next step. Also, you can use the Show issues button to preview the 

individual issues for the desired series.

Editor’s Choice

http://www.bedetheque.com
http://coa.inducks.org/index.php
http://www.comicvine.com
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Managers
These scripts modify comic book information. Using these scripts, you can specify rules to automatically enter 
metadata, you can get c2c/noads tags and scan Information from filename, erase first page advertisements, copy 
or move information from one metadata field to other, and much more.

Copy or move information from one 
field to another

Import scanner names from the file 
name into the Scan Information field

Mark the first page as advertisement 
and following page as the front cover

If you are using ComicRack to organize your comic 
library there is sometimes the need to enter data 
based on rules. So you might want to set the se-
ries group to Gotham for all Batman books. Or 
you want to set the publisher information for the 

first 200 issues of Walt Disney’s Comics and Stories to Dell instead 
of Boom. This script will complete all these tasks automatically. 

The Data Manager also has its own project page. Here you can find 
more information regarding the advanced use of this script, as well 
as download the latest version.

To open the Data Manager, select a book (or a 
batch of books) and either click the yellow icon 
on the library browser toolbar, or Right-click → 

Automation → Data Manager. Click Start Scraping 
to begin the automated process.

A ruleset is a directive that tells the Data Manager 
what it shall do. A ruleset can be e.g.:

If Series is ‘Batman’ then set SeriesGroup” to 
‘Gotham’. A ruleset consists of rules (in this 

example: If Series is ‘Batman’) and actions (in this 
example: Set SeriesGroup to ‘Gotham’).

Before you run the Data Manager for the first time you have to define your rules. 
A rule set consists of two parts. Part one defines the rules or criteria the Data 

Manager uses to decide which books shall be treated. Part two defines the actions 
which Data Manager should take based on your rules.

You can organize your rules in groups, use action templates & make profiles.
Read the Data Manager manual to know more!

Editor’s Choice
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Organizers
These scripts move, rename or delete files based on the comic book metadata. Using these scripts, you can or-
ganize, un-dupe, and convert your comic books. The Library Organizer script is the Editors’ choice in this group.

Remove duplicate comic books with 
just a single click! (Read the wiki)

Convert selected comic books to 
fileless entries

Move all selected comic book files to 
a chosen folder

The Library Organizer script allows for a highly 
customized user-specified organization (rename/
copy/move) of the selected books and/or the 
windows explorer folders. 

The Library Organizer provides options for organizing your comic 
book files into folders, as well as renaming your files. 

The Library Organizer also has its own project page. Here you can 
find more information regarding the advanced use of this script, as 
well as download the latest version.

You must first manually set the Base Folder which would serve as the destination 
for the files being copied/moved. The next two tabs of the configuration dialog 
provide options for folder organization and file naming. These tabs contain a num-
ber of metadata buttons that you will recognize from that in the Info dialog. Using 
these metadata buttons, you can design your directory/file structure. Making 
rules is an optional step. The Rules tab has the Folder Rules & the metadata rules.

To open the Library Organizer, select a book (or 
a batch of books) and either click the yellow icon 
on the library browser toolbar, or Right-click → 
Automation → Library Organizer. The Configura-

tion dialog will open up.

You may need different structures for different 
categories of books. Once you have defined the 

file/folder structure, you can save it as a profile for 
quick use next time. You can save as many profiles 

as you need. You can also export profiles for 
backup or for sharing.

Editor’s Choice

http://code.google.com/p/comicrack-duplicates-manager/
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Smart List Scripts

Smart list Scripts are a special category of scripts that can be used only with smart lists. On creating a new smart 
list, the Edit Smart List dialog box pops up. It contains a metadata field called User Scripts. Scripts used in accord-
ance with this field are called Smart list Scripts. 

Find books where the files are not 
found on the drive

Pull series based on how many 
issues it contains

Find comic books that contain 
proposed values

This script displays unread or partially read comics where the previous issue in the 
series has been completely read. Just select the smart list in the sidebar, and you 
now get all comic books where the previous issue has been completely read.

This is a smart list script that pulls comics that have any pages marked with the en-
tered type. The page type can be specified from any of the ones present in the pages 
context menu.

Set the metadata field 
(first drop-down menu) to 

User Scripts

Set the instruction field 
(second drop-down menu) 

to Next Issue To Read

Set the metadata field 
(first drop-down menu) to 

User Scripts

Next to the instruction 
field is the option text 

box. Here you write the 
Page type. Click Ok once 

you are done

Set the instruction field (second drop-
down menu) to Books with pages marked

The script ignores any comic book that has been opened till the first 3 pages. This comes in useful when you are in the 
habit of opening up newly added comic books just to get a look at them. Comic books that have been read further than 
3 pages are considered by the script partially read, and therefore displayed. However, you can change the number of 
pages to be ignored by editing the New Comics.py file.
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Info Panels Scripts

Info Panel Scripts are a special category of scripts that can be used only with the Info Panel. The Info Panel is 
an ‘optional’ panel that opens in the browser, using either the Browse menu, or by clicking the Info Panel dock-
ing grip at the bottom of the browser window. However, the Info panel doesn’t show up till any Info panel script 
is enabled. Here we detail the currently popular Info Panel scripts.

Display a coverflow of the selected 
comics in the Info Panel

Shows most of the available metadata of the se-
lected book(s) in the Info Panel, without requir-
ing to invoke the Info dialog. With the info panel 
enabled and the series info panel script installed, 
select a comic book (or a group of comic books). 

The Info Panel  will show almost all the available metadata in a visu-
ally elegant manner. 

The Series Info Panel can be easily configured to suit your needs. To open the options 
window, from the Main menu, go to File menu → Automation → Series Info Panel Options. 
You can select the metadata fields you wish to be displayed in the Info panel (series view & 
issue view). The Skins drop-down menu lets you choose from a number of skins. The Series 
Info Panel can display any number of pages from the selected comic book in the form of a 

filmstrip at the bottom of the panel. 

Editor’s Choice

CoverFlow is an animated, three dimensional graphical user interface for visually flipping through thumbnails of 
selected comic books. You can browse the Coverflow using the mouse wheel scroll or left/right keys. Clicking on a 
comic book opens it in the reader window.
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From the preferences dialog, you can choose to turn off the Price, 
Cover and Publisher columns in the right pane of the  weekly comic 
releases window.

Enhancers
These scripts enhance the basic functionality of ComicRack to give you more functions, many of which could well 
have been in-built by default. But, as not all users would choose all of them, so we have made the scripts, and 
you can choose your pick. These include automatic backups, getting RSS feeds of new comics, and many more.

Automatically back up your 
ComicRack database

Create a new script that executes sev-
eral scripts one after the other

Extract all the pages of a comic book to 
a user specified folder

Weekly Comic Releases gets 
you the latest RSS feeds about 
the new comics coming out 
each week. You can filter the 
results by date, title or pub-

lisher. The blacklist function excludes results 
from unwanted publishers is there. You can also 
export the comic list to a text file or to fileless 
comic entries in your ComicRack library. To open 
the script, from the Main menu, go to File menu 
→ Automation → Weekly Comic Releases

This script allows you to extend ComicRack by adding your own “Open With” program short-
cut to the right click Automation menu. Add as many items as you need by running it multi-
ple times. When you are choosing file types, be SURE that the program you select will handle 
those file types, otherwise the program will probably give you a nasty error message about 
not recognizing that file type.

Right click on a comic book, select Automation, and you’ll see “Open With Some-
thing You Typed”.

From the main menu select File → Automation → Build ‘Open 
With’ Menu Item... . The script will prompt you for a label and 
the comic book file types you want to allow be used



If you like to read 
comics published  on 
a website, ComicRack 
can download, save 
and update them for 
you. Read this chapter 
to learn how!
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Web Comics: Basics

ComicRack supports Web Comic (.CBW) files. A CBW file loads the comic pages from the official site of the web 
comic. The CBW file itself will contain no image files. With Web Comics, ComicRack can read comics directly 
from web pages and display them as if they were standard digital comic archives (CBR, CBZ). Web Comics can be 
exported to other formats. If the definition supports it, a Web comic can update itself to add new pages (like for 
daily or weekly comics). 

Where do I get CBW files?

Very simply, CBW files are just small XML files that can be edited using any text editor (like Notepad++). For additional 
information on making Web comics, please read the article on the ComicRack wiki page. Here we focus on 3 common 
(and easy) ways of getting web comics:

WEB COMIC HELPER
This is the easiest way. The Web comic 
helper is a script freely downloadable 
from the ComicRack forum. Install the 
script & enter the required links (as 
instructed by the script dialogs) to make 
the .CBW file for the web comic of your 
choice. We discuss this script in detail on 
the next page.

COMICRACK FORUM
Just login to the ComicRack forum and go 
to the Index of Web Comics. Our devel-
opers there have already posted a good 
collection of Web comics that you can 
download and use. New Web comics are 
regularly posted and requests for specific 
Web comics are entertained.

TEMPLATES
A Web comic template can be easily 
edited to make the Web comic of your 
choice, which you can read (with daily 
updates) from within ComicRack. Tem-
plates for Gocomics.com (a website that 
contains a large number of daily comics) 
and Onemanga.com (a website contain-
ing lots of manga) can be freely down-
loaded from the ComicRack forum.

http://comicrack.cyolito.com/documentation/wiki
http://comicrack.cyolito.com/user-forum
http://comicrack.cyolito.com/forum/22-web-comics/13924-index-of-web-comics-cbws
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Web Comic Helper

This script will allow you to easily read just about any web comic on the Internet 
from within ComicRack. Read the entire archive without waiting for each page 
to load, get automatic updates for new pages, and, of course, view and manage 
your web comics just like any other e-comic. Just download the script and install 
it. Go to File -> Automation, and then select Webcomic Helper. Follow the on-
screen instructions and the script will make the CBW file.

1 2 3

5

4

Enter the URLs Let the script retrieve the page sources Fill in the metadata

Click Finish You can now read the web comic!

Save the web comic to a location of your choice

http://code.google.com/p/comicrack-webcomic-helper/
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Working with Web Comics

ComicRack treats Web comics just like standard eComics. All features of ComicRack have the same level of func-
tionality for Web comics as well. The only difference is that reading a Web comic is dependent upon the speed 
of your internet connection. This also depends upon the total number of Web comics in your collection, the in-
ternet cache size, and the dates from which the Web comics begin (overall size of a Web comic). In most cases, 
however, the individual pages of a Web comic are rather small in size & get updated very quickly. 

Drag-and-drop any CBW file into the Browser to add it to the ComicRack 
library. Double-click it from the browser to  open it in the reader window 

as the pages get downloaded. If your file is in the Library, then the page at 
which you have stopped reading the web comic should be remembered so 
the next time you open the web comic, this last page should be displayed 

instead of the first page.

Double-clicking any web comic (.CBW file) from Windows Explorer opens 
it directly in the ComicRack reader and starts displaying the pages as they 

are downloaded from the web. The Status bar shows the name of the open 
Web Comic, the current page, & the page count of the open book.

While a Web comic is updating, clicking on the Pending background 
tasks indicator reveals the pages getting downloaded.

Just like with normal comic book archives, you can open up the Info dialog 
for Web Comics, and view and edit their metadata.
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Use this option in the File Menu to 
manually update your web comics.

Check this option in the Behavior tab of the 
Preferences dialog to get automatic updates

From the Details tab of the Info dialog, you can choose whether to include 
a particular Web Comic in the updates or not.

You can view the current status 
of the web comic update in the 
pending background tasks indi-
cator. Once the Web comic has 
been updated with new pages, 
you will see the red star state in-
dicator on the web comic thumb-
nail in the browser. The number is 
the number of new pages. Once 
the new pages are read, the red 
stars disappear. 

Updating Web Comics

As Web comics link to comics from web pages, they need to be regularly updated to keep reading the latest 
pages. 

There are 2 ways to update:
1.	 Manual Updates: From the File Menu → Update Web comics 
2.	 Automatic Updates: From Preferences → Behavior → Starting ComicRack → Select the option Update Web 

comics. This way, ComicRack will check & download all updates for all your Web comics on startup.

If you wish to save a Web comic for offline reading, just export it to a 
place on your computer. The Export eComics function works for Web 
comics with exactly the same functionality as it does for regular eCom-
ics. Please note that the Web comic would be exported only till the last 
page that has been retrieved from the net. While exporting Web com-
ics, it is not recommended to delete the original pages after export, 
as ComicRack would have to download them again if you re-update it.

Offline reading!

Right-click the Web comic from the browser and go to the Export eComics 
option. Choose your preset, or use options in the export dialog to fine-

tune the export process to your choice.



You can access 
remote comic book 
libraries of your 
friends and family 
using the network 
sharing features of 
ComicRack. You can 
even share your 
database with others!
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Opening Remote Libraries

Using the network sharing functionality of ComicRack, you can open the shared library of other ComicRack us-
ers over the internet. In this section, we explain how to work with remote libraries, while the next section will 
focus on sharing your own library with other ComicRack users. Please follow the copyright laws for file sharing 
in your region.

1 2

3 4

The remote library will load in the Browser Tab Bar next to  the Library tab. 
Double-clicking on any comic book will retrieve it from the user’s library and 

open it in the Reader. The time taken to completely download the comic book 
depends on your internet speed and the file size. The remote library supports all 
the functions of ComicRack, just like your library. Group, arrange, stack, reorder, 
recolor, search shared comic books just like you would do for the regular ones.

Double-click on any library name, and ComicRack will try to connect to the server 
to get information about the shared library. The Shared library opens up in the 
Browser Tab Bar next to  the Library tab, and it tries to open connection to the 

remote server. If the library is password-protected, you will be asked to enter the 
password to retrieve the library.  

The Open Remote Library dialog will open. The names and description of available libraries can be seen. 
Also seen are the Edit and Export properties for the shared libraries. Please note that the        icon indicates 

a password-protected library, for which you’ll have to contact its user through the ComicRack forum. 

Click on the Open Remote Library option 
either from the File menu, or from the Tools 

menu.
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Click the Add/Remove Share 
button to add/remove mul-
tiple libraries. New shares 

appear in tabs alongside the 
open library.

Choose a good password (recom-
mended). Decide if you would 
like to keep your share private. 
Choose whether you would like 
clients to have editing & export 

privileges. Please note that if ex-
port is not allowed, they won’t be 

able to save the comic books. 

Choose a name & (mean-
ingful) description for your 

library. 

Share selected 
reading lists or all 

your library.

Drag the slider to increase 
or decrease the page quality 
& the thumb quality of the 
comic books in your shared 

library.

If you are sharing your library over the network, you will see a round icon at the extreme right of the Status Bar; 
this is the Server Statistics button, clicking which will open the Server Statistics tab of the Tasks Dialog display-

ing all the detailed server statistics for your shared library.

Enabling Network Sharing

There Is no way for a user to request the password to your library unless he recognizes your 

shared name. This is only possible if you use your ComicRack forum username as the name 

for your shared library. This way other users can PM you on the forum, and you could reply 

back your password to those you wish.

Why should I keep my shared name same as my ComicRack 

forum username ?FAQ

Now that you have learned how to access other users’ shared libraries, you will definitely like to share your own 
library with your family and friends. We will now discuss how you can do this with ComicRack. This functionality 
has a slightly different set up if used within a LAN or over the Internet. 

To enable network sharing, go to Edit menu → Preferences → Libraries tab → Sharing section → Click Add Share. 
Here you can also select if you want to share your complete library or only selected lists. You can also select to 
make your library password protected (recommended) or editable. 
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Sharing over the Internet

If you have a very large library and a slow connection, your clients may encounter errors 

when they try to access your shared library. If it happens, try sharing only part of the library 

instead, by going into Edit menu → Preferences → Libraries tab → Sharing section → Click 

Share selected lists (instead of Share All).

Why do my friends get an error message when they try to 

access my remote library?FAQ

The configuration needed for sharing a ComicRack library over 
the internet depends on how you connect to the internet. You 
can, for example, connect to the net simply by attaching an ex-
ternal modem to your desktop. Alternatively, you may be con-
necting via a router. Here we discuss these scenarios, along with 
the steps required to share your library. 

The following steps are required for enabling network sharing for ComicRack  
for a PC connecting to the internet via a dial-up / DSL / cable modem:
1.	 Allow ComicRack access to your firewall 
2.	 Enable network sharing, via Edit menu → Preferences → Libraries tab → 

Sharing section → Click Add Share
3.	 Choose from all the options as described earlier, and click Ok.
4.	 Restart ComicRack
5.	 Now your ComicRack is ready for sharing your library over the internet. Users who would like to access your 

library have to follow the steps outlined in the Opening remote libraries section of this chapter. 

Sharing via a modem

If the computer sharing the library is behind a router, you will need to follow 
these steps:
1.	 Go to the Router configuration, to a section called “Port Forwarding” (or 

similar, varies across brands)
2.	 Create a new port forwarding for the port 7612 TCP, so that the External port 7612 is forwarded to the IP of 

the computer sharing the library. For example, if the IP of the computer sharing the library behind the router 
is 192.168.0.5, you will need to forward port 7612 TCP to 192.168.0.5:7612.

3.	 Allow ComicRack access to your firewall 
4.	 Enable network sharing, via Edit menu → Preferences → Libraries tab → Sharing section → Click Add Share
5.	 Choose from all the options as described earlier, and click Ok.
6.	 Restart ComicRack
7.	 Now your ComicRack is ready for sharing your library over the internet. To connect to this shared library, 

other users have to open ComicRack on their computer and go to File → Open Remote Library. Enter the 
external IP address of the router. If the port forward is done correctly, they should see a new tab appear with 
the shared library name.

Sharing via a router

Typically when 
ComicRack starts for the 

first time, you’re presented 
with a pop-up window ask-
ing if you want to allow or 

block its access. Check Allow 
access to allow ComicRack 
to communicate on both 
private & public networks.
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Using a Shared Database

ComicRack 1.64 and up support putting your library into a shared SQL server. For now only the book information 
is stored in the SQL server. Smart lists and configurations are stored in the local user profile. This is an experi-
mental and advanced feature and requires some knowledge on how to setup SQL servers. MySQL and Microsoft 
SQL servers are currently supported. All ComicRacks accessing the shared database MUST have the same (latest) 
version.

ComicRack by default stores the database into a local file named ‘ComicDb.xml’. This file is loaded when starting 
up, and regularly saved in the background when data changes. This means that it is possible to lose data when 
your system fails, as the saving is not done immediately after changes to the data occur. Also it is not possible to 
share this database with other users. Every user (on the same system or network) has to maintain his/her own 
database. Using a shared database solves all these problems. Users can share a library and changes get saved to 
the database immediately.

Why use a shared database?

As always, before playing around: MAKE A BACKUP OF COMICDB.XML!
You need to create an empty database with full access rights on your server. Usually you would create a new user 
(let’s say comicrack) and a new database on your server (let’s say comicdb):

Mysql
For mysql, considering 192.168.100.3 the address where you have comicrack running, you could do the follow-
ing to set up the database and user. Bold shows commands you have to type:

On comicrack.ini, you should then add:

If you use MySQL add the following line to your comicrack.ini file

Should you use a Microsoft SQL server (this sample uses integrated security)

The first time you start ComicRack with these new settings ComicRack will create the structure in the database, 
copy all your local entries to the database (this can take some time) and delete your local database.

mysql -u root -p
Enter password:
(type the root user password for mysql)
mysql> CREATE DATABASE ‘comicdb’;
Query OK, 1 row affected (0.00 sec)
mysql> CREATE USER ‘comicrack’@’192.168.100.3’ IDENTIFIED BY ‘PASSWORD’;
Query OK, 0 rows affected (0.00 sec)
mysql> GRANT USAGE ON *.* to ‘comicrack’@’192.168.100.3’ IDENTIFIED BY ‘PASSWORD’;
Query OK, 0 rows affected (0.00 sec)
mysql> GRANT ALL PRIVILEGES ON comicdb.* TO ‘comicrack’@’192.168.100.3’;
Query OK, 0 rows affected (0.00 sec)
mysql> exit
Bye

DataSource=mysql:Server=192.168.100.5; Uid=comicrack; Pwd=PASSWORD; Database=comicdb;

DataSource=mysql:Server=your_server; Uid=your_user; Pwd=your_user_password; Database=your_database_name;

DataSource=mssql:Data Source=your_data_source; Initial Catalog=your_catalog_name; Integrated Security=True

Setting up your SQL server



Now that you 
have read all the ba-
sics, it’s time to jump 
into some advanced 
features. Here we also 
give solutions to some 
common queries often 
asked by many users.
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ComicRack.ini File

The ComicRack.ini file is the advanced configuration file for ComicRack. It is located in the install location of 
ComicRack (usually C:\Program Files\ComicRack). You can change the settings by uncommenting (remove the 
semicolon ‘;’ before the key word) the required line. ComicRack.ini changes are not kept between updates, be-
cause if you re-install ComicRack, the original ini file gets overwritten with the default settings. However, you can 
put a ComicRack.ini file in %PROGRAMDATA%\cyo\comicrack or %APPDATA%\cyo\comicrack. You don’t need 
a full file there, just the settings you change. The file in your %appdata% folder will override any conflicting op-
tions. This way, the settings will not revert to defaults when installing a new ComicRack version.

You can also try to tweak ComicRack for your low 
powered system. Write the following line into your 

ComicRack.ini:
TextureManagerOptions = BigTexturesAs16Bit

You can also try to reduce/expand the size of texture 
memory available with the line:

MaxTextureMemoryMB = Your Graphics card Memory

If you want to change the number of lists displayed in 
the QuickOpen box, just change the value at the end 

of the following line in your ComicRack.ini file:
; QuickOpenListSize = 10

You can also hide the default smart lists in the 
QuickOpen box by changing this option to ‘true’:
; ReplaceDefaultListsInQuickOpen = false

If your C drive is short on space, you can change 
where the Temp and Cache files are stored. You can 
do this two ways: via a command switch or changing 

the ComicRack.ini file. 
Locate these lines in the comicrack.ini: 

; TempPath =

; CachePath = 

Remove the ; character and put in the full paths 
after the = sign.

For low-powered PCs
Changing QuickOpen

Changing Temp/Cache

The caption is the text you see below the thumbnail & tiles in the Browser window. 
The default style of the caption is:  Format/series/title/volume/number/year/month

If you wish to change it, just open the comicrack.ini and look for this line:
; Format of eComic captions

;  ComicCaptionFormat = [{format} ][{series}][ - {title}][ {volume}][ #{number}][ ({year}[/{month}])]

Alter it to what you wish to change, for example:
  ComicCaptionFormat = [{series}][ - {title}][ #{number}][ ({year}[/{month}])]

or
  ComicCaptionFormat = {filename}

This will also change how eComic titles are displayed in the library view, as well as the titles in the open tabs.

Change Caption

You can change the default value of days a Book date is 
treated as ‘recent’ by changing this line:

; IsRecentInDays = 14

Similarly, the completion percentage where eComic is 
treated as ‘Read’ can be changed by altering these:

; IsReadCompletionPercentage = 95
; IsNotReadCompletionPercentage = 10

Changing Default lists
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Command Description

In this example, we add the -ac [Config Name] 
command-switch to the target field. We write doc for 
the [Config Name] field, so the switch reads -ac doc. 
Starting ComicRack from this shortcut brings on the 
default ComicRack window with an empty library. 

Add the command switch at the end of the default 
target (after the “ mark, put a space and write the 

command). The command switch should follow the 
format listed in the table below. 

Save this new shortcut by clicking Ok. 

Make a shortcut to ComicRack.exe, or copy & paste 
a pre-existing shortcut. Right-click on this new short-

cut, and click Properties.
Identify the Target field. The default target reads: 

C:\Program Files\ComicRack\ComicRack.exe

Command-line Switch

2

Command-line Switch?
A command-line switch (also known as a command line parameter, 

flag, or an option) is an indication by a user that a computer program 

should change its default output. For example, in the OpenVMS 

operating system, the command directory is used to list the files 

inside a directory. When the user simply types directory, it will list 

only the names of the files. By adding the option /owner (to form 

the command directory/owner), the user can instruct the directory 

command to also display the ownership of the files.

1 2a 2b

ComicRack supports a number of command-switches 
that modify its default configuration to the one speci-
fied by the user. Please note that ComicRack will follow 
the command parameter only when it is run from this 
shortcut that you have created. If you do not want the 
switch, simply run it from the default shortcut.
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Multiple Libraries

If more than one user is using a ComicRack install on a single PC, they would like to have their own reading stats, 
lists and ratings. ComicRack has the capability to support (with a few limitations) multiple shared databases on 
a single PC. You would need to know about the Command-line switches supported by ComicRack. There are two 
ways of having more than one library on a single PC. You can either make multiple configurations, or change the 
database path. Both of these are detailed below.

You *could* share the library file by using the -db command line switch 
or setting it in comicrack.ini. But because ComicRack reads the database 
only at startup and then only writes changes back, you’ve to make sure 

that no two copies of ComicRack run at the same time or you would lose 
changes.

With the -db database switch you can start ComicRack with a different 
database. This way two ComicRacks can use the same database file (with 

the described limitations).

You can also set this in ComicRack.ini by changing the database path. 
Look for this line in the comicrack.ini file:

; DatabasePath =

Remove the ‘;’ and set a new directory for it to store the database file

Start comicrack with the -ac CONFIGNAME parameter. This will create a 
subfolder in your Comicrack Appdata folder, and everything will be like a 
fresh install (including your preferences, lists, etc.). Make as many more 

copies as the number of libraries you need. Rename each one to the 
name of your library. You need to launch the program at least once for 

the appdata folder to be created.

If you ever want to delete one of them, just delete the relative folder 
from 

%appdata%/Roaming/cYo/Comicrack/configurations

If you want to delete the ‘main’ library, remove everything BUT the con-
figuration folder from %appdata%/Roaming/cYo/Comicrack/

Change Database Path

Make new configuration

Go to %appdata%/Roaming/cYo/ComicRack and remove the ComicDb.xml file (and the 

ComicDb.xml.bak file, if you want to get rid of the backup, too). This will completely remove 

the old library. 

How do I completely remove old library & start a new one? 

I tried to uninstall ComicRack, but the old library stays on despite the complete uninstall.FAQ
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Portable ComicRack

Many users like to run ComicRack from a portable location, like an external hard drive. This is useful in many sce-
narios, the most common being the ability to use the same Comicrack database on multiple systems. Just make 
sure that the portable drive is mapped to the same driver letter on every machine. A portable install needs just 
the altering of a line in the ComicRack.ini file. Here are the steps to do this:

Install ComicRack to the portable location you 
want.

Edit the ComicRack.ini file in the directory. 
Remove the ‘;’ from the line:
; UseLocalSettings = true

Run the ComicRack.exe from the portable 
location. This should create a new database, 
settings and cache in the installation directory 
(\ComicRack\Data\). Please note that you 
may need to Run as Administrator for 
ComicRack.exe after changing the .ini file.

When you make ComicRack portable, it doesn’t copy over the database already there, it starts a new blank one. 
So, if you are wishing for a fresh database, it is fine. However, if you already have a database as a regular install 
of ComicRack, and now wish to make it portable AND retain the old database, here is what you need to do:

1.	 Backup the database
2.	 Make ComicRack portable by uncommenting UseLocalSettings = true in the ini file
3.	 Copy the entire ComicRack installation directory to you portable drive
4.	 Open ComicRack and restore the database from the xml file you backed up in step 1

The Local settings option makes all the settings and database files save to subfolders 
within the install folder. So regardless of what computer you use it should use the 

same files. Thus your settings and database remain the same. 
Note that the ComicRack still needs .Net version 4 on whatever PC you use it on.

1

2

3

ALL THE STEPS

1.	 Put all your comics on a NAS. 
2.	 You computer has to be running ComicRack, which must remain running for the sharing to 

work. Once you close it the sharing stops.
3.	 That computer has to have the ports 7612 & 7613 open and forwarded. Then load the com-

ics (located on the NAS) into the library. 
4.	 Configure the sharing options in the preferences menu of ComicRack. 
5.	 Once you have the sharing set up you should be able to access your library from any com-

puter on the same LAN and, assuming you set it up, from the internet as well. 

Reading comics on NAS

Please note that although a NAS can run some simple apps, it can not run an operating system able to run ComicRack. 
So, you can’t run a portable ComicRack install from a NAS.

NAS?
Network-attached storage 
(NAS) is a dedicated hard 
disk storage device that is 
set up with its own network 
address and provides file-
based data storage services 
to other devices on the 
network. NAS systems are 
networked appliances which 
contain one or more hard 
drives, often arranged into 
logical, redundant storage 
containers or RAID.
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Formatting my PC

Sometimes you may be faced with the unfortunate situation of having to format your computer, or simply move 
on to a new system. As a regular user of ComicRack, you wouldn’t want to add all the metadata again, and make 
all the lists & settings that you spent so much time on. Here we discuss the best ways to preserve your ComicRack 
install between system formatting.

Make a copy of the entire %appdata%/cyo/comicrack directory. 
If you made changes to ComicRack.ini in program files, then 
make a copy of that too.

Copy the comics to the new computer and put them in the EX-
ACT path they are in on the current one, meaning if they are at 
c:/users/owned/comics on the current one, they need to be in 
that location on the new system. The folder structure must be 
identical.

Install ComicRack on the new system.

Copy the contents of %appdata%/cyo/comicrack to the %app-
data%/cyo/comicrack directory on the new system (it may not 
be the same exact path if user name is different but that’s fine in 
this case) and overwrite everything. If you need to, also put the 
ComicRack.ini in the program files and overwrite the default).

This is usually a hidden folder. To access it, just write 
%appdata% in the Windows Explorer address bar, and 
hit Enter. Backing up this ComicRack folder backs up 
absolutely everything, including features not backed 

up by the in-built database backup.

1

2

3

4

ALL THE STEPS

Make sure that you have enabled the ‘Allow writing of book 
info into files’. Also, you can turn on ‘book files are updated 
automatically’, as ComicRack only saves the changes made 
to the database on closing. If everything is in cbz and has 

the metadata automatically updated then this is much less 
of a crash/data loss if/when it happens.

•	 It is considered a good practice to convert all your books to 
CBZ so that metadata can be stored in the archive itself. If you 
enable writing of book info into files, ComicRack can save the 
comic metadata inside CBZ files. However this is for CBZ (or 
CB7) only. CBR files won’t have this information saved inside 
the archive. 

•	 The ComicBookDB.xml contains all the metadata. You can 
easily export this file from ComicRack in the Preferences dialog. 
Note however that this file uses absolute paths to determine 
where the files are. If you don’t put your comics files in the 
exact same place on the new system all the files will be marked 
as missing. 

•	 You can get automatic backups with the Backup Manager 
script. You can create/restore backups manually by going to 
Edit -> Preferences -> Advanced and hit either backup or re-
store database. Please note that the following features are not 
backed up by the in-built backup manager: workspaces, list lay-
out presets, options from preferences dialog & export presets.
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Comics with a Red X

If you see a big X in place of the cover image, it ap-
pears to be a case of corrupted archives, or even, 
few corrupted image files in the archive. You need 
to follow these steps to get the comic working:

1.	 Unpack archive to a different folder.
2.	 Repack archive and rename to EXACTLY as the parent 

file.
3.	 Move and replace old file with new archive. ComicRack 

now shows the actual pages instead of the giant red X.
4.	 If rearchiving doesn’t work, there may be some bad 

JPEGs in the archive. Convert the pages (using a program 
like XNview) from jpg to bmp back to jpg then rearchive 
the file.

ComicRack displays a small red X icon for all files 
that it can’t locate. Here is what all you can do:

•	 If you have moved the file to another location that is 
included in the scan folders (Preferences dialog), then 
you may simply restart Comicrack to re-scan at startup 
& the file will be located in the scan.

•	 It is always considered a good practice to move files from 
WITHIN ComicRack, using the Move eComics script. 

•	 Another option is to use the in-built Search and Replace 
script on the filename within comicrack. It will re-point 
the database to your new location. You only have to 
search and replace the main folder as long as you don’t 
change the folder structure.

Big X with no cover Small X with cover

Sometimes ComicRack may show some books with a Red X icon . Users find that they can open the file fine and 
read it in several other cbr/cbz readers. Many-a-times this is simply the case of users moving their files to another 
location, say, an external hard drive. But sometimes, the fault may lie within the archives themselves.

If your drive letters get changed, ComicRack faces problems locating these comics. The easi-

est way to fix this is open the comicdb.xml in %APPDATA%\cyo\comicrack with a text editor 

and replace all E:\ with F:\ or whatever your letters are. 

How to deal with a changed drive letter? 
I changed the location of my main comics folder from E:\Comics to F:\ComicsFAQ
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Managing new books

Convert to CBZ
As you already know the importance of 

having CBZ files for storing the metadata 
information (as comicinfo.xml file), you 
should first preferably convert all the CBR 
files to CBZ files. Make a smart list that 
pull all the books which are CBR archives. 
Select all the books pulled by this smart list, 
and convert them to CBZ, using the Export 
books function from the browser right-click 
context menu.

ComicVine Scraper
Make a smart list that picks up all the 

newly added books in the library. These are 
the books that have largely empty metadata 
fields, save for those that Comicrack 
automatically picks up from the filename 
(like series, year, number). Now run the 
ComicVine Scraper script on all these comics. 
The metadata fields will now automatically 
get filled via the information from the comic 
vine website.

Add Scanner Info
While the scraper fills in most of the 

fields, it cannot find the scanner’s name (for 
obvious reasons). You need the Scan info 
from filename script for that.

Make a smart list to pull all the books 
which need to have the scanning information 
filled up. Now, just run the Scan info from 
filename script on the books pulled by your 
newly made smart list!

CVDBSKIP
The comic vine scraper may miss some 

books due to lack of data in the comicvine 
website. Add a CVDBSKIP tag to these books 
by holding the CTRL key when pressing the 
skip button on the scraper. Make a smart list 
that pulls all the CVDB skip books. Fill in the 
metadata fields for these books manually.

  Commit Proposed Values
The Proposed Values are metadata 

auto-discovery that ComicRack does 
by processing the filename. It’s there for 
convenience, so those fields stay in grey 
till the user confirms (or ‘commits’) them. 
Also, the uncommitted values will not be 
recognized by the Data Manager. So it is 
highly recommended to either commit them 
permanently (from the browser context 
menu Automation -> Commit proposed 
values) or hide them (if the guess is wrong) 
and manually over-write them. 

Duplicates Manager
Use of ComicRack’s in-built duplicates 

finder plus the excellent duplicates manager 
script. This script basically chooses which of 
the duplicated comics to keep (and which 
to delete) based on the rules you specify. 
So first, you need to setup the rules for the 
duplicates manager script. From the Views 
menu on the browser toolbar, choose the 
Show duplicates option. Now select all the 
books in the browser and click the duplicates 
manager button on the browser toolbar.

Data Manager
The Data Manager script fills in the 

metadata based on the rules specified by 
the user.  Settings up the rules for the first 
time would require some time & effort, but, 
in the long run, this saves you a lot of work. 
After the books have been scraped, and 
the proposed values committed, just select 
them click the Data manager icon from the 
browser toolbar.   

Library Organizer
The Library Organizer script allows for a 

highly customized user-specified organization 
(rename/copy/move) of the selected books 
and/or the windows explorer folders. User-
defined settings decide the manner in which 
the script works. First select the books on 
which you wish to run the Library Organizer 
on. Now, click on the Library Organizer icon 
in the browser toolbar, or Right-click -> 
Automation -> Library Organizer

Clean-up
Correct books with incorrect ‘of’ values. 

e.g. 4 (of 3) using the Count Errors smart list. 
This needs to use a single regular expression 
based criteria: Expression is True {StatsMa
xCount}<>{StatsMinCount}. You would now 
need to manually correct the count fields in 
the books pulled by this list.

Use the series gaps smart list to find the 
comics which are missing in a series run 
present in your library. The smart list needs 
to follow any of these 2 rules: Series: Start of 
gap is Yes and Series: End of gap is Yes. 

ALL THE STEPS

Name "CBR Finder"
Match [File Format] contains "rar"

Name “CVDBSKIP”
Match [Tags] contains “CVDBSKIP”

Name “Scrape Me”
Match [Publisher] equals “”

Name “Add Scanner Tags”
Match [Scanning Information] equals “”

New users want to organize things first and then add them to the library, while actually it is the other way 
around. You are supposed to put all your books (no matter how unorganized they are) in one folder and then add 
it to the library. Tell ComicRack to check the folder for changes, and scan it on every startup. Now, make a smart 
list for all the unorganized books, and then work your way up to organize them VIA ComicRack.

1 2 3

54 6

7 8 9
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Some FAQs

How can I display my comic archives as  thumbnails in Windows Explorer ?
Just install the free software CBXshell from here: 
free-sk.t-com.hr/T800/software/cbxShell.htm

What is the Position field used for?
The position field is editable in a custom list only. It allows you to slide the books up and down on 
a list without having to use an alternate number or another predefined setup to make a smartlist 
work. However, if you ever replace a book in your library with a newer/better version of that book, 
the old one will be removed from the list and you’ll have to figure out where you had it previously.

I was trying to update the author & other info but I can’t. All the fields are 
greyed out, not allowing me to select anything.
It seems that you are trying to edit metadata for files which you have not yet added to the library. 
First add your books to the library (read manual for how to do so) & then you’ll get editing capa-
bilities ‘unlocked’.

How do I completely remove the tags? I’ve already tried doing it manually in 
the details tab, but the same old tags get put back up. 
The trick is to remove the tag not only from the tags field of the details tab but also the notes field 
of the plot & notes tab. You can clear the tags AND notes in the Multiple comic book Information 
dialog. Check them both and clear the contents (if any).

Is there a smart list to find comics that are not in any lists?
Create a folder, put all your smart lists inside that.
Then, outside of the folder you created, let’s call it “ALL MY LISTS” for example, create a smart list 
like this:
Name “Unsorted Books”
Not In [ALL MY LISTS]
Match [All] contains “”

I recently had a crash. I never backed up my database. Can I still recover?
If your database goes bonkers and you have never made a backup or don’t have a recent one, 
check for comicdb.xml.bak in %appdata%\roaming\cyo\comicrack and if it’s there make a copy 
of it and the remove the .bak extension.

If I convert my comics from CBR to CBZ, will there be a loss in image quality? 
Which format takes more disc space? Which is preferable?
CBR and CBZ are pretty much identical when it comes to file size, and exactly identical when it 
comes to image quality. But ComicRack can be configured to save your metadata into your Comic 
archives, so it needs to be able to edit your files. That’s possible with CBZ files, because the zip 
archive format is completely free and open for programmers to use. ComicRack can still do edits 
on CBR files without breaking any licensing rules, but those edits can get lost when you move the 
files to another computer. So, we recommend the CBZ format.

Q
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“There was a time when users often complained
of the lack of a manual on ComicRack. Making the ComicRack 

manuals was a challenge for me, a fun challenge.
I know that people learn best when information is 

engaging, clearly written, and visu-
ally appealing. Unfortunately, most 

manuals read like dry catalogs. This is 
why I started writing the manuals on 

ComicRack.”

More by the same Author

If you like ComicRack...
You are encouraged to donate a small 

amount to support this project and keep it 
running. ComicRack has no functional limi-
tation whatsoever if no donation is made. 
Hundreds of hours of work have been put 
into ComicRack to make it the best, most 
versatile and simply the most fun to use 
comic book reader and manager in the 

world. Starting out as a small fun project, 
it has evolved into what you currently see, 
a multi-language application with its own 

web site and support forums. So if you 
think ComicRack adds value to your life, 

please give something back.
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